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This manual is the instructions for use for MyoStrain® version 6.

& Warnings:
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MyoStrain, the user must follow all the Contraindications and Warning from the MR imaging manufacturer, to ensure the
safety of the patient and the staff.

e  MyoStrain is designed for the analysis of SENC MR images of the heart. The results of quantification will depend on the
image quality.

e  MyoStrain, is intended to be used by the physician along with other indicators, such as patient history and pain level, to
determine the diagnosis of the patient.

e Any serious incident that has occurred in relation to MyoStrain should be reported to Myocardial Solutions Inc. as well as
the competent authority of the Member State in which the user/patient is established.
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1. INTRODUCTION

This User’s Manual was written to assist you with a better understanding of MyoStrain and to maximize the
efficiency of the software. Use this manual to look up information, find out what you need to know, and start your
work.

1.1 USING THIS MANUAL

This manual is designed to provide a thorough description of how to use the software to analyze cardiac magnetic
resonance (CMR) images.

The following symbols and formats are used to denote different types of instructions:

e All user interface elements have been marked in bold.

e Additional information on application functionality or features can be found in small notes.

NOTE: Notes are written in this format.

@ Example: Examples are written in this format.

Caution —Important cautionary information such as warnings and precautions
Information —Consult instructions for use

Manufacturer — Identifies who developed and released the MyoStrain software.

ELE&

Authorized Representative — Authorized representative in the European community

uUDI Unique Device Identifier — Indication that a Unique Device Identifier is present

Medical Device — Indication that the device is a medical device

Importer — Identifies the representative who verifies the device conforms with applicable
regulations required for importation in the EU.

& 5

1.2 ABOUT MYOCARDIAL SOLUTIONS

Myocardial Solutions, Inc., based in RTP, North Carolina, is a privately held company specializing in unique MR
imaging and diagnostic solutions for research, clinical, and OEM markets. “Our mission is to give patients control
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over their heart health, providing physicians with unique diagnostic solutions to help transform the detection,
prediction, and management of heart dysfunction.”

1.3 INTENDED PURPOSE

This section will document the intended purposes of MyoStrain, which will include information such as intended
patient population, intended medical indications, contraindications, performance, and benefits.

1.3.1 INTENDED USE

MyoStrain® is a software medical device designed for the quantitative assessment of myocardial strain using
cardiac magnetic resonance images collected using SENC or fast-SENC pulse sequences.

1.3.2 INTENDED USERS

MyoStrain® is intended for use by healthcare professionals in clinical settings.

1.3.3 INTENDED PATIENT POPULATION
MyoStrain® is intended for adult and pediatric patients with suspected or known cardiomyopathy, heart failure,
cardiotoxicity, and coronary artery disease. It can also be used to monitor patients with no symptoms.

1.3.4 INTENDED MEDICAL INDICATIONS

MyoStrain® provides information that is used for the diagnosis and classification of cardiomyopathy, heart failure,
cardiotoxicity, and coronary artery disease.

1.3.5 CONTRAINDICATIONS

MyoStrain® does not have contraindications.

1.3.6 BENEFIT CLAIMS

MyoStrain® reduces the exposure to MRI contrast agents

1.3.7 PERFORMANCE CLAIMS

Measured Parameters -

MyoStrain® measures directly the following parameters, derived from the MRI images or strain data without
additional complex mathematical analysis or advanced analysis.

e Global Strain measurements
MyoStrain (GLS) LV — Average percentage of peak strain calculated from all Short-Axis LV slices.
MyoStrain (GCS) LV — Average percentage of peak strain calculated from all Long-Axis LV slices.
MyoStrain (GLS) RV — Average percentage of peak strain calculated from all Short-Axis RV views.
MyoStrain (GCS) RV — Average percentage of peak strain calculated from all Long-Axis RV views.

e Traditional measurements
MyoStrain® can perform the following traditional cardiac measurements:

LVEF — Percentage of blood emptied from the left ventricle during systole.

LVED Volume — Volume (mL) of blood measured in the LV at Diastole measured across all

Long-Axis images. LVED Volume is also displayed as indexed values (mL/m”2) based on body surface area (BSA)
LVES Volume — Volume (mL) of blood measured in the LV at Systole measured across all Long-

Axis images. LVES Volume is also displayed as indexed values (mL/m”2) based on body surface area (BSA)

LV Stroke Volume — Difference of volume (mL) between the LVED Volume and LVES Volume. LV Stroke Volume is
also displayed as indexed values (mL/m”2) based on body surface area (BSA)
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RVEF* - Percentage of blood emptied from the right ventricle during systole.

RVED Volume* - Volume (mL) of blood measured in the RV at Diastole measured across all

Long-Axis images. RVED Volume is also displayed as indexed values (mL/m”2) based on body surface area (BSA)
RVES Volume* - Volume (mL) of blood measured in the RV at Systole measured across all

Long-Axis images. RVES Volume is also displayed as indexed values (mL/m”2) based on body surface area (BSA)

RV Stroke Volume* - Difference of volume (mL) between the RVED Volume and RVES Volume. RV Stroke Volume is
also displayed as indexed values (mL/m”2) based on body surface area (BSA)

The performance of MyoStrain® is defined by the Limit of Agreement (LOA), established through Bland-Altman
analysis, which quantifies the agreement between MyoStrain® and Cardiac MRI (CMR), as presented in Figure 1-1

Parameters Limit of Agreement
LVEF [-10; 13] (%)

LVED Volume [-23; 25] (mL)

LVES Volume [-17; 15] (mL)

LV Stroke Volume [-23; 27] (mL)
RVEF* [-18; 19] (%)

RVED Volume* [-22; 47] (mL)

RVES Volume* [-22; 32] (mL)

RV Stroke Volume* [-28; 43] (mL)

* Semi Auto Contouring must be enabled, and a completed 3D model is required to generate these
measurements

Figure 1-1: Traditional measurements using MyoStrain®

Quantified Parameters
MyoStrain® quantifies the following parameters based on the measured values.

e Dysfunctional Segment Quantifications (Threshold-Based Classification)

Number of LV Segments > -10% — This displays the total number of LV segments calculated by MyoStrain® to have
above -10% strain.

Number of LV Segments > -17% — This displays the total number of LV segments calculated by MyoStrain® to have
above -17% strain.

Number of RV Segments > -10% - This displays the total number of RV segments calculated by

MyoStrain® to have above -10% strain.

Number of RV Segments > -17% - This displays the total number of RV segments calculated by

MyoStrain® to have above -17% strain.

e MyoHealth® Scores

LV MyoHealth®- Derived measurement showing percentage of LV segments equal to or below -17% strain
compared to the total number of LV segments analyzed. It can be expressed by the formula below

RV MyoHealth®- Derived measurement showing percentage of RV segments equal to or below -17% strain
compared to the total number of RV segments analyzed. It can be expressed by the formula below

MyoHealth® Score = [(# of V Segments <= -17%) / (# of V Segments Analyzed)] * 100
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1.3.8 RISKS AND SIDE EFFECTS

As with all medical devices, MyoStrain® has the potential for side effects. Possible side-effects considered in the
literature for diagnosis software for cardiac activity are related to delay to diagnosis and disruption of subsequent
medical procedures.

Clinical data from MyoStrain®, and literature review on diagnosis software for cardiac activity have not highlighted
increased risk of this side effect associated with the software application. Figure 1-2 summarizes the side-effects of
MyoStrain®.

Side-effect Probability
Delay to diagnosis Rare [0- 0.15%]
Disruption of subsequent medical procedure Rare [0- 0.15%]

Figure 1-2: Side Effects of MyoStrain

1.3.9 EXPECTED PRODUCT LIFETIME

The "expected lifetime" of the medical device, is 10 years from the date of release.

1.4 DEVICE SPECIFICATIONS

1.4.1 GENERAL DESCRIPTION OF THE DEVICE

MyoStrain® is an image processing software designed to analyze cardiac magnetic resonance (CMR) images for
assessing myocardial function. It processes MRI-encoded images acquired using a pulse sequence (SENC/fSENC). The
software extracts time-resolved, quantitative strain data per voxel along with other cardiac measurements.
MyoStrain® quantifies longitudinal and circumferential strain to describe myocardial wall motion, offering tools to
display regional motion properties and variations. MyoStrain® generates clear, easy-to-read reports with intuitive
graphics making clinical cardiac imaging reporting efficient and reliable. The reports are interpreted by physicians to
support diagnostic decision-making.

1.4.2 DESCRIPTION OF MATERIALS
Not applicable. MyoStrain® is software, delivered electronically. MyoStrain® does not incorporate any medicinal
substances, tissues, or blood products.

1.4.3 ACCESSORIES, OTHER DEVICES AND OTHER PRODUCTS

No accessories are available with the MyoStrain® software.

1.4.4 SYSTEM REQUIREMENTS

Recommended Hardware Requirements

* 2.8 GHz i5 Generation 7 Processor (equivalent or better)

¢ 16GB memory or higher

* 100 GB available hard disk space for installation and additional space for image storage.
¢ 1920x1080 screen resolution

¢ Dedicated GPU with at least 2gb onboard memory

¢ 1000Mbps LAN/Ethernet port

¢ .NET Framework 4.8 (installed alongside MyoStrain® if not present)

¢ Visual C++ Redistributable Package 2019 (installed alongside MyoStrain®)
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Operating System
The MyoStrain® application is currently supported on Windows 11 (64-bit) Pro, Windows Server 2022, and
Windows Server 2025 (Standard)

1.4.5 PRINCIPLES OF OPERATION OF THE DEVICE AND ITS MODE OF ACTION

MyoStrain® an image processing software designed to process cardiac magnetic resonance (CMR) images for
assessing myocardial function. Unlike the MRI acquisition pulse sequence, which is used to generate raw cardiac
images, the MyoStrain® uses specialized pulse sequence (SENC/Fast SENC) to quantify regional myocardial strain,
providing a direct measurement of myocardial function. Then, the software combines the processed images to
generate a color-encoded strain map of the heart, where the blood pool is suppressed (black blood imaging), and
myocardial strain is visually represented using a graded color scale.

1.4.5.1 IMAGE ACQUISITION AND PROCESSING

MyoStrain® is an advanced cardiac imaging software built on the SENC and Fast SENC pulse sequences, utilizing
linear tagging to capture myocardial motion in a single direction.

SENC (Strain-Encoded MRI) uses a fixed frequency encoding to encode strain information directly into the MR
signal. Signal intensities change as the heart contracts (systole) and relaxes (diastole), reflecting regional
myocardial strain. The strain information is then extracted by analyzing intensity variations in response to
myocardial deformation.

SENC (SENC) employs an alternating frequency encoding pattern—low and high tuning—enabling faster
acquisition by encoding strain at multiple depths simultaneously. These encoding variations influence signal
intensities based on myocardial deformation.

These technologies enable direct and highly precise strain measurements of both the left and right ventricles with
exceptional spatial resolution. Designed for efficiency, MyoStrain® provides rapid and reproducible strain
assessments in as few as one to three heartbeats. By leveraging the speed and accuracy of SENC-based imaging, it
offers a powerful and reliable tool for evaluating myocardial function, ensuring high-quality cardiac assessments in
clinical practice. A detailed presentation of the features SENC and fast SENC is provided in Figure 1-3.
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Characteristics

SENC

Fast-SENC

Developed since

2008

2017

Tagging type

Uses linear tagging (one direction
through the heart muscle layers)

Uses linear tagging (one direction
through the heart muscle layers)

MRI sequence pulse

- Modulated SPAMM (Mod-SPAMM)
- Single-shot GRE (Gradient Echo)

- bSSFP (Balanced Steady-State Free
Precession)

- Rapid Modulated SPAMM with
Optimized bSSFP
- Spiral SENC

Application

Quantifies global and regional strain

Quantifies global and regional strain

Resolution

High spatial resolution

High spatial resolution

Breath-holding

Requires single breath-hold

No breath-holding required

Heartbeat required

4-8 heartbeat/plane

1 heartbeat/plane

Analysis time

Requires dedicated pulse sequence

Analysis time (<10 min)

Speed

Fast

Faster

Complexity

Easy

Simplified

Best case use

Clinical use, early disease detection

Clinical use, early disease detection

and Stress tests, real-time strain
monitoring
Figure 1-3: Overview of the technical features of SENC and Fast-SENC sequences

1.4.5.2 STRAIN MEASUREMENT AND ANALYSIS

Strain is a quantitative measure of myocardial deformation, expressed as the fractional change in tissue length.
MyoStrain® calculates strain on a pixel-by-pixel basis, with:

e Shortening (contraction) represented as negative values, e.g., a 25% reduction in myocardial length during
systole is shown as -25%.

e Lengthening (stretching) represented as positive values, e.g., a 5% stretching in an aneurysmal infarct
during systole is shown as +5%, which is very rare.

MyoStrain® provides precise measurements of regional myocardial strain for both the left ventricle (LV) and right
ventricle (RV), enabling detailed characterization of cardiac contraction and relaxation. The software automatically
extracts strain data from the encoded images and generates quantitative strain maps that help detect ischemia,
myocardial infarction, or other functional impairments.

The MyoStrain® analysis provides a detailed report of intramyocardial muscle deformation, dividing the left and
right ventricles into 48 segments. Each segment is assigned a peak mid-myocardial strain value and a
corresponding color for visual interpretation. Since strain is a negative value reflecting myocardial contraction, a
higher peak mid-myocardial strain number (i.e., a lower absolute strain value) indicates reduced contractile
function in that region.

MyoStrain® does not interact directly with patients but assists physicians in visualizing, calculating, and assessing
regional myocardial function. The software also includes MyoHealth® a derived measurement that represents the
percentage of ventricular segments with strain values equal to or better than -17%. This metric is displayed only if
at least 30 of the 37 left ventricular segments and 8 of the 11 right ventricular segments are analyzed. The
MyoHealth® score is calculated using the following formula, for left and right ventricles:

MyoHealth® = [(# of V Segments <-17%) / (# of V Segments Analyzed)] * 100
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1.4.5.3 USER INTERFACE AND REPORTING
The software features an intuitive graphical user interface (GUI) designed for efficient operation with minimal user
interaction. It computes a comprehensive set of strain-derived measurements and motion indices, facilitating in-
depth cardiac function analysis. MyoStrain® also includes a reporting module that allows results to be formatted
into standardized clinical reports, which can be reviewed and interpreted by physicians to support diagnosis and
patient management. Figure 1-4 presents the first page of the MyoStrain® report showing a visual representation

of the 48 myocardial segments, highlighting strain values and the MyoHealth metric to facilitate clinical

interpretation. The Global MyoStrain Strain Values are classified as follows:

e Normal Strain: <=-17% (healthy myocardial function).

e Borderline Dysfunction: Between -10% and -17%.
e Severe Dysfunction: Above -10% (high risk of myocardial dysfunction).

LV Dysfunctional Segments
(37137 Segments Analyzed)
Number of Segments >-10%
Number of Segments >-17%

Longitudinal MyoStrain® Measurements

LV MyoHealth™ (% Normal Segments =-17%)

Circumferential MyoStrain® Measurements

1.5 CYBERSECURITY

Figure 1-4: MyoStrain® Report for 6.1 (Template-1, Default AHA Model)

81%
81% J) emm—— -
00% BO% 60% 40% 20% 0%
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Inferoseptal % Inferoseptal -179% Inferior -224%
Inferior Inferior -127% Laters! A7T%
Inferclateral Inferclateral -112%
| Anterolatesal % Anterolatersl 7%
| Anterior Anterior -186%
Lateral Lateral -273%
Infenoc % Inferior -22%
3CH{HR:80) 4CH{HR:-79) 2CH(HR77)
| Basal Inferolateral -213% Basallnferoseptum  -237% Basal Inferior -221%
Mid Inferolateral -214% Mid Inferoseptum -186% Mid inferior -146%
Apical Lateral -218% Apical Septum -178% Apicallnferor  -243%
Apical Cap -23% Apical Cap -194% Apical Cap -219%
Apical Antenor -227%  Apical Lateral -241% Apical Anterior -249%
Mid Anterosepturn -18% Mid Anterolateral -24% Mid Anterior -245%
| BasalAnteroseptum  -173% BasalAnterotersl  -184% BasalAnterior  -179%
| Basal Anterior -175% Basallateral -228%
RV | wid Anterior -193%  Mid Latera! -229%
Apical Lataral -176%

MyoStrain is only available from Myocardial Solutions, and installations are only authorized on systems identified
as being secure. Myocardial Solutions requires that the below practices are being followed before authorizing

installation or upgrades of MyoStrain:
e Access to the workstation (internally and externally) is limited to only authorized and trusted users of

MyoStrain.

e  Access to the workstation is monitored

e Only trusted content (including MyoStrain and its software libraries) will be loaded onto the workstation
e The workstation is equipped with mechanisms designed to detect, respond to, and recover from malware or
other compromising applications (Anti-virus, anti-malware software, firewall)
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e The workstation must automatically log off and restrict access after a reasonable period

o A backup and disaster recovery plan should be in place on the workstation

e Integrity and confidentiality of data transferred to and from the workstation must be monitored
e MyoStrain data stored on the workstation is encrypted

A log of actions performed by the user are recorded and is accessible to administrator users on the workstation. If
LDAP is being used, only an LDAP authorized administrator user can access the logs.

1.5.1 TRANSMISSION OF DATA

MyoStrain can be configured to use any network ports to receive and send data. MyoStrain will only open ports
and network paths to locations where the workstation or application is provided access to. Myocardial Solutions
will work with the facility to ensure the ports are secure.

MyoStrain will not knowingly transmit data to any devices or systems not identified as a connected PACS server
(Section 10.1). MyoStrain will only receive DICOM formatted data sent to it as part of a configured node system.
MyoStrain will not transmit any information to an outside server or service without express confirmation on behalf
of the operator. Information related to the receiving of data from across a network is logged and is available on
the workstation running MyoStrain. The log files can be found in the following path, where (USER) is the logged-in
user’s name: C:\Users\(USER)\AppData\Local\Myocardial\MyoStrain Test\Logs.

After any data has been sent to MyoStrain, it will be stored in a folder specified during the installation (Default
path is C:\MyoStrain\). Datasets sent to MyoStrain will be stored in the same state it is received until manually
updated.

1.5.2 ENCRYPTION OF DATA

All information related to the processing of image data during a software exam (.myo save data files) is encrypted.
This information cannot be accessed except by MyoStrain. Encryption of image data as well as secure transfer of
data is a requirement of the facility prior to installation of the MyoStrain software. When utilizing a network based
DICOM transmission system, data sent to the MyoStrain workstation will be encrypted at rest. The encryption
algorithm being used is AES-256. If a user-supplied encryption key is used, MyoStrain will be unable to provide the
ability to recover any encrypted data if this key is lost.

1.5.3 INTEGRITY OF DATA

MyoStrain will perform a check periodically to verify the integrity of system files and ensure repeatable results on a
known dataset. This check verifies analysis integrity if the workstation’s cybersecurity has been compromised. This
check (known as Self-Check) is conducted upon installation of the software, a reorder form is generated, upon
request, or after a year has passed since the last Self-Check. MyoStrain will not launch if this test fails. Please
contact Myocardial Solutions (support@myocardialsolutions.com) for more information.

1.5.4 COMPROMISE OF DATA (INCIDENT RESPONSE PLAN)

In the event that MyoStrain has detected unauthorized modifications to itself or its licensing, MyoStrain will cease
operation and will not permit further usage of the software. If MyoStrain is not functioning normally (or if the
workstation is suspected to be compromised), please contact Myocardial Solutions (+1 919.677.8100, or
support@myocardialsolutions.com) to identify the problem and to restore MyoStrain functionality.

1.5.5 AUDIT LOGGING
A record of user actions and file access is recorded in MyoStrain and available for view through the
MyoConfigurator. The following actions are recorded and stored in an encrypted database only accessible by an
authorized Administrator user of the workstation, or by administrators of MyoStrain through LDAP:

e  Successful/failed logins (LDAP only)
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e Opening/Creating new exams

e  Exporting data/DICOM images

e Modifying an existing exam (the slices/stages modified from the original exam are recorded)

e Deleting a dataset from the MyoWorklist

e Timeout due to inactivity (LDAP only)
Records are stored for a configurable amount of time (6 years default), and the location can be selected by the
user. More information regarding accessing Audit Logs can be found in Chapter 10.

1.6 UNINSTALLATION (PERSISTANCE OF DATA)

If MyoStrain is to be uninstalled from the workstation, please contact the Myocardial Solutions Support team
(support@myocardialsolutions.com) prior to doing so. Depending on your site’s configuration, some information
needs to be documented prior to the software being removed. This is to ensure that if MyoStrain is being moved
from one workstation to the next, existing license or networking information can be recorded and transferred.

Settngy
@ Home Apps & features
Relates s=ttings
| Choose where to get apps S g
Amn Instaling apps only from Migrosoft Store helps protect your device
Anyywhere
| E Apos & reatures
Help from the web
5 Default apps Apps & features
l Offine maps
T
Search, sort, and fiter by drve. If you would ke 10 ursnstadl or
Gl Apps for websites move an app. select it from the ist
-
o Video playback MyaStrain
2 Swanup Name Al drives @
1 app found :
MyoStrain Test 6.0 627 M8

Figure 1-5: Recommended method of uninstalling MyoStrain

It is recommended to use the Apps & Features setting in the Settings menu of Windows to uninstall MyoStrain.
Once the MyoStrain software is uninstalled, the following paths will retain data regarding past analyses:

1. C:\MyoStrainBackUp
2. C:\MyoStrain
3. C:\Users\[USER]\AppData\Local\Myocardial\

These paths do not include the locations of exams analyzed using MyoStrain. MyoStrain will not delete exam data
of past analyses during its uninstallation. It is the responsibility of the site or user to archive, backup, and delete
exam information from the workstation after MyoStrain has been uninstalled.
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2. GETTING STARTED

This chapter explains the installation and default operation of the MyoStrain analysis software.

Prior to using the MyoStrain software in a clinical or research setting, training from the Myocardial
Solutions team on proper usage is required. Please contact your Myocardial Solutions representative
or (support@myocardialsolutions.com) for more information.

2.1 INSTALLING MYOSTRAIN V6.

The MyoStrain installation process on the workstation is a very simple and straightforward process. Installation is
performed on-site and configured by Myocardial Solutions on a site-by-site basis. If your site needs to install or
reinstall MyoStrain, please contact Myocardial Solutions’ support team (support@myocardialsolutions.com) to
arrange an installation session.

| "8 MyoStrain Test 6.1 - InstallShield Wizard X

Welcome to the InstallShield Wizard for
MyoStrain Test 6.1

. The InstaliShield(R) Wizard will install MyoStrain Test 6.1 on
your computer, To continue, click Next.

international treaties.

1
\WARNING: This program is protected by copyright law and “

Figure 2-1: Installation Window

1. Launch the MyoStrain installer. Click the Next button when the installation screen shown in Figure
2-1 appears.

2. Please read the license agreement, and if you agree select the “l accept the terms in the license
agreement” option shown in the second installation window (Figure 2-2).
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3. The Configuration stage of the installation wizard contains site-specific information which may
change from site to site. Please contact your site administrator or Myocardial Solutions for more
information on these fields.

b | MyaoStrain Test 6.1 - InstallShield Wizard X

License Agreement

Please read the following license agreement carefully.

IN ORDER TO INSTALL AND USE THE SOFTWARE KNOWN AS MYOSTRAIN®
IN OBJECT CODE FORM (THE “SOFTWARE™) YOU MUST ACCEPT ALL OF THE
TERMS OF THIS END USER LICENSE AGREEMENT (THE “AGREEMENT?). IF
YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT. YOU WILL NOT BE
ALLOWED TO USE THE SOFTWARE.

1. You understand and acknowledge that your installation and use of the Software is
subject in all respects to the Myocardial Solutions. Inc. (“Myocardial™) Software
License and Maintenance Agreement pursuant to which the Software has been made
available to you (the “SLMA™).

; © 1 accept the terms in the license agreement Print
(7)1 do not accept the terms in the license agreement

| InstallShield

Figure 2-2: End User License Agreement — Accept must be selected to continue.

4. After the Configuration information has been set, click Next. Select Install on this last page to initiate
the final step of the installation process.

2.1.1 UPGRADING TO V6.

If a previous version of MyoStrain is already installed on the workstation, the MyoStrain installation package will
upgrade the installed version to the current release.
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5 | MyoStrain Test 6.1 - InstallShield Wizard X

Welcome to the InstallShield Wizard for
MyoStrain Test 6.1

The InstaliShield(R) Wizard will install MyoStrain Test 6.1 on
your computer, To continue, dick Next.

Warning! You are about to upgrade your product to
a higher version. By proceeding,you will assume
responsibility for any backups of previous data.The
SENC installer will make an effort during the
upgrade to copy your data, but in the event of loss
or incorrect data migration, please refer to
previous backup.

Figure 2-3: Installation Wizard — Upgrading

Upgrading to version 6. will attempt to import settings from the previous installation, including PACS server
information and Worklist data. During the installation process, a directory must be created to store this
information for upgrade, by default MyoStrain will use C:\MyoStrainBackup.

NOTE: The MyoStrain installer will always attempt to upgrade an existing MyoStrain installation. To bypass
upgrading, first uninstall the current MyoStrain installation. Ensure the MyoStrain program as well as the
MyoWorklist are closed before uninstallation/upgrading.

2.2 ACTIVATING MYOSTRAIN V6.

Upon launching MyoStrain for the first time, or if the MyoStrain Application license has expired, the Registration
dialog box will display as shown in Figure 2-4. Copy the value given in the Username field and email it to Customer
Support (support@myocardialsolutions.com).

=

\4 Registration Myocardial Solutions

Username 9D C201C09233 860D 1D 47 C8328A5CTF2520 DEFC OF [ Change NIC l
Application License [ Cancel l
Exam License [ Register l

Figure 2-4: Registration dialog box
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2.2.1 MYOSTRAIN SELF CHECK

After installing MyoStrain, when a Reorder request is started, or a year after the last check, a Self-Check will be run
by the program. This Self-Check system verifies the integrity of installed files on the workstation, then runs a
diagnostic analysis to verify measurements being read by the application.

My Self Check

Self Check Test

Analyzing...

Figure 2-5: Self Check running

A progress bar will appear once the test has begun. After the check has been completed, a dialog box will appear,
detailing information regarding the test. If the Self-Check fails, please contact Myocardial Solutions’ Technical
Support for more information (support@myocardialsolutions.com). The program will not run if the Self-Check fails.

s

4B Self Check has finished,
QW' Total time taken: 44.2 seconds

= status: Passed

Figure 2-6: Successful Self Check notification

2.3 IMAGE IMPORTATION

MyoStrain provides multiple different methods to import images for analysis. While the methods for importing
images may differ, the end goal of quantifying a series of strain images stays the same.

2.3.1 INPUT IMAGES REQUIREMENTS

MyoStrain imports and analyzes SENC images, which are acquired with SENC-ready MRI systems. SENC-ready MRI
systems are MRI systems equipped with the SENC pulse sequence. SENC images are identified by specified DICOM
series attribute 'SENC'.

NOTE: fSENC (also known as Fast-SENC) is another name for images acquired using the SENC Pulse Sequence.

2.3.2 INPUT IMAGES RESTRICTIONS

MyoStrain processes SENC images and measures the strain in the through-plane direction. The specific strain
measured will depend on the orientation of the imaging plane. Circumferential strain is measured from long-axis
planes of the heart, while longitudinal strain is measured from short-axis planes.
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i‘_\ The prescription of the planes is the responsibility of the MRI scanner operator, who should be
properly trained on cardiac imaging and the recognition of the correct views of the heart.

The user of MyoStrain can verify the right orientation (angle tilting) of the acquired planes by reviewing the
location and orientation of each plane relative to the anatomical images, as seen on MyoStrain screen. The user
therefore can match the type of the strain measured to the location and orientation of the plane.

While MyoStrain can import any properly formatted image, it cannot identify what is an analyzable image. Image
quality, acquisition, and other factors can prevent the accurate quantification of image data. Accuracies of
measurements are associated with images that were correctly acquired and analyzed by trained operators. It is the

responsibility of the trained MRI operator and MyoStrain users to check the quality of the acquired images before
post-processing them using MyoStrain.

Other acquisition issues can cause the images to be unanalyzable. Below are 3 examples of mis-acquisition.

12%

LV

No Apex of the LV

Figure 2-7: Sample Image of 2-chamber view with planning issue

Figure 2-7 demonstrates an image that needs to be re-acquired. In this example, the apex of the 2-chamber view

is not captured at systole. During acquisition, the patient shifted their body and caused the heart to fall outside of
the field of view. This would require a new acquisition.

User’s Manual LBL-1041EU_EN Rev F for v6.1 Page 21



LV . LV

)
U C ,‘

Figure 2-8: Two images of the same 2-chamber view

Figure 2-8 demonstrates an acquisition that began at end-systole (frame 2/11, left) instead of end-diastole (frame
10/11, right). Rather than showing the complete cycle of the heart going from end-diastole, to end-systole, and
back to end-diastole, this series is only showing the relaxation from end-systole to end-diastole. This caused the
strain to not be applied to the dataset. If the dataset does not show the full diastolic to systolic cycle, the series

should be rejected.
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Figure 2-9: Unidentifiable

Figure 2-9 should be rejected as well. In this example, the acquisition plane was not set correctly. For reference,

this image is of a 4ch Long-Axis slice. This would require a reacquisition.

All images used for analysis demonstration in chapter 4 can be considered of good analysis quality.
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2.3.3 LOCAL FILE IMPORT

In most circumstances, images being analyzed in MyoStrain are typically coming directly from the scanner. In
cases where networking is unavailable, or images copied off a CD or flash drive need to be analyzed, local file
import is available.

i) MyoStrain ®Test[Exam_3]

File View Help

Mew Exam Ctrl+MN

Mew Exam from Waorklist

MNew Exam from Folder {

Open Analyzed Exam...

Open Recently Analyzed Exams #

Export 4

Reorder

Show Exam Licenses
Setup 4
Exit Alt+F4

Figure 2-10: Image Import from Folder (New Exam) option found in the File menu

To import a local dataset, click on File>New Exam from Folder from the File menu found in the upper-left hand
corner of the MyoStrain application. A Browse for Folder dialog box will appear, prompting the user to select a
folder containing DICOM images. All images contained in the folder (this includes any subfolders found in this
folder) will be imported into MyoStrain and organized according to stress stage found in the medical image header.

All MyoStrain data used as part of the analysis will be stored in that folder. Image data will be maintained in that
folder and is the responsibility of the Facility’s IT department to find a secure location to archive and store this
exam information.

2.3.4 REMOTE FILE IMPORT

MyoStrain has the capability to import images from a remote location (DICOM Server, PACS, Scanner) through a
DICOM network connection. For more information regarding remote file importation, please refer to chapter 10.

After any data has been sent to MyoStrain, it will be stored in a folder specified during the installation (Default
path is C:/MyoStrain/). It is the sole responsibility of the Facility’s IT Department to ensure that any data sent to
MyoStrain is accessed, managed, and archived for future use.

For more information regarding the MyoWorklist, please refer to chapter 10 for more details.

2.4 DICOM CONNECTIVITY CONFIGURATION

When MyoStrain 6. is installed, an additional service named MyoWorklist is also installed on the workstation. This
service is responsible for managing datasets sent to the application for retrospective analysis from other
computers via DICOM. MyoStrain will only receive data pushed from remote locations it has been configured to
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receive from and can be configured to receive data from multiple devices. Please contact your PACS or network
administrator or support@myocardialsolutions.com to setup this feature. You can also refer to section 10.1 for
more information about DICOM connectivity configuration and how to enable MyoStrain to receive images
remotely. A DICOM Conformance Statement is available upon request.

NOTE: Only DICOM formatted data can be transferred through this configuration.

2.5 ERROR REPORTING

When using MyoStrain, very rare circumstances may cause the application to encounter an error. If an error does
occur, please send the entire error message to Customer Support (support@myocardialsolutions.com) along with
your name and the organization/practice you are affiliated with. A representative will contact you to help
troubleshoot your issue.

P "

Error @

Program has encountered an internal error (Error ID: MYO_ERROR_0054)!
Please contact Myocardial Selutions for mere information

OK

Figure 2-11: Sample error message
In the rare case MyoStrain crashes without generating an error message, please contact Customer Support
(support@myocardialsolutions.com) describing any actions preceding the crash. A Customer Support
representative will be in contact to assist in troubleshooting the error.

2.6 EXAM LICENSES

MyoStrain operates by using an exam credit once images are received by the application in Stress or Strain analysis
mode. If the application no longer has any exam credits remaining, it will not receive or process any new images.
To order additional exam credits, launch the About menu by clicking on the Myocardial Solutions logo found below
the ‘X’ at the top-right of the application window.

About/Licensing

exams remaining

Figure 2-12: License information is available from this menu

The About menu, available from both the Exam Selection screen as well as the main program, displays relevant
information related to the software license. Exam credits can be requested or added into the program from this
menu. Additionally, the Reorder process can be initiated from the File menu by selecting the Reorder button.
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Figure 2-13: Exam selection screen shown at beginning of new exam or at launch with Reorder option highlighted

To view detailed exam license information, click on the Show Exam Licenses button shown in the File menu (Figure
2-13), and at the top of the About menu (Figure 2-14). This will display another menu which will display all the
exam licenses available to the workstation and their duration (Figure 2-15). Exam licenses will always be
consumed starting with the first entry, then cascading down the list until no additional exam licenses are available.

Product: MYOSTRAIN [MD
Product Version: 6.1
Release date: 2025-09-09
Copyright: © 2025 Myocardial Solutions Inc. All rights reserved
Company Name: Myocardial Solutions Inc,
License Strain Remaining: 1000
Show Exam Licenses
License Stress Remaining: 1000

Figure 2-14: Additional exam license information can be found in the About menu

’

Start Date Expiration Date Strain exams left Stress exams left Remaining Day(s) Confirmation Code
2020-01-20{2021-01-20 |50 |50 | 366 | Nk

Figure 2-15: List of exam licenses available to the workstation running MyoStrain.

2.6.1 ORDERING ADDITIONAL EXAM LICENSES

NOTE: Please check with your organization’s ordering procedures before submitting a request for additional
licenses.

Clicking on the Reorder button found in the bottom-center of the About menu will launch a new popup window
(Figure 2-16). The Reorder form can also be launched from the File menu.
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Name User Name

Erval rame@site ext
Phane Numiber 9195778100
HospitalFacivty Myocanisl Appled Scences

Number of exams requested
MyoSiran® 00
MycStress® 200
Seit-Creck
Status Passed

Time Taken  104.3 seconds

Cear Friet Expont

Figure 2-16: License Reorder Form Wizard

After filling in all the required fields (marked by a red asterisk), including a number for Strain and Stress, a report
will be available for export. Clicking on the Print button will bring up a Print Dialog box (Figure 2-17) allowing the
user to print out a physical copy of the report (provided a printer is available).

{_ Print Dialog — O W
Printer MName Microsoft XPS Document Writer vi
Paper Size Letter v
Paper Crientation Portrait -
Print ] [ Cancel l

Figure 2-17: Selecting Print from this window will generate a physical copy of the Reorder Form

A digital copy can also be created by using the Export button from the License Reorder window (Figure 2-18) as
well. Select a location to export the report to using the Choose Folder button, rename the Reorder form using the
File Name field, then click Save to export the report.

W Export Reorder Form

Choose falder C E]

File name MSI_Rearder_20240404) |

Save l [ Cancel ]

Figure 2-18: Digital copies of the Reorder form can be created here
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Once the Reorder form has been created, it must be attached to the Purchase Order sent to Myocardial Solutions
for processing. Please refer to the chart below for details on where this Reorder form should be sent.

Email
Fax

orders@myocardialsolutions.com
+1(919) 591-0404

NOTE: orders@myocardialsolutions.com will not contact you or reply directly to emails. A representative will

contact the person listed on the Reorder form, or directly with the person who sent the email if there are any

errors.

2.6.2 ADDING ADDITIONAL EXAM LICENSES

By clicking on the Myocardial Solutions logo found either on the Select Your Exam or main application window, an
About dialog box will appear (Figure 2-19). Clicking on the Exam License button will open the Registration window
(Figure 2-20). Copy and paste any new license codes into the Exam License field and click Add to add additional

exam credits.

Product:
Product Version:
Release date:
Copyright:

Company Name:

License Strain Remaining:

License Stress Remaining:

MYOSTRAIN |MD!

6.1

2023-09-09

® 2025 Myocardial Solutions Inc. All rights reserved

Myocardial Solutions Inc,

Show Exam Licenses

99

*+B672MYOSTRAINO60/$8053501X*

Address:

Myocardial Solutions Inc

4819 Emperor Bivd, Suite 140,
Durham, NC 27703

Phene: +1-877-677-8514
+1-819-677-8100

support@myocardialsclutions.com

User's Manuals can be found at www.myocardialsolutions.com/iabels

Appiication Expiry Date: 2030-10-28

[«

Reorder I I Exam License,.. I | Application License...

Figure 2-19: MyoStrain About page
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i3 Exam License

Username 47 F9 DO BB 9B 6E D4 CO 91 EE OF 84 18 F3 E3 84 45 AC AT 67

Exam License Add

Figure 2-20: Exam License entry screen

NOTE: License codes generated by Myocardial Solutions expire 7 days after being issued.

2.7 APPLICATION LICENSE

In addition to the Exam License, the software is also governed by an Application License. This license determines
how long the program will remain active and able to review exams created in the program. The Application License
can be found by clicking the Application License button found in the About screen. If the Application License is
expired, MyoStrain will not launch and instead display the Registration window seen in section 2.2.

Expiry Date: 2021-01-20

oK [ ’ Reorder I l Exam License... , ‘ Application License... I
(_ Application License X
Username 4998 13FO 77 CO9A9AA6C 4078 CA4B2ATA39F5 AC159C | Cancel I

Current License  |4C-60-44-34-0B-64-19-£6-40-89-5E-27-16-98-B5-D6

New License | Upgrade |

Figure 2-21: Application License menu

NOTE: The MyoStrain Application license is separate from the Exam License. MyoStrain will continue to run if there
are no remaining Exam credits, however it will be limited to reviewing previously created MyoStrain exams.

2.8 CLOSING MYOSTRAIN / WORKSTATION MAINTENANCE

Once finished performing analyses in MyoStrain, it’s important to shut down the application. This is accomplished
by clicking either the X button in the upper right corner of the screen, or by selecting File>Exit option in the
application menus.

When closed, MyoStrain will still be able to receive images sent to the workstation and queue them in the
MyoWorklist for analysis.

It is highly recommended that MyoStrain is closed before any Windows Updates are applied to the workstation. It
is highly recommended that Myocardial Solutions’ Support is contacted prior to performing any hardware
modifications to the workstation. Changes to the hardware of the MyoStrain workstation may cause the
Application License to become invalidated. Any configuration changes to the DICOM network should also be
reported to Myocardial Solutions to ensure the transfer of SENC formatted images to the MyoStrain software will
not be impacted.
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3. APPLICATION OVERVIEW

This chapter provides a visual overview of the MyoStrain® application, describing settings and features relating to
MyoStrain visualization and quantification. MyoStrain is comprised of 3 different modules: Analysis, MyoHealth®
Review, and Report.

3.1 THE MYOSTRAIN® ANALYSIS WORKSPACE

The MyoStrain application is comprised of three windows with several panes used to display information relevant
to the current patient’s images being analyzed by the software. Most of the data displayed is generated as part of
the MyoStrain analysis protocol and minimal interaction is required to display/retrieve this information. When
importing a new dataset for analysis, the Analysis tab is what MyoStrain will initially display. It can also be
accessed by clicking on the Analysis button in the top-middle portion of the application.

@ Example: For a MyoStress exam, each stage of this scan will be available in the application and organized
accordingly, with the lowest and highest stages of stress displayed by default.

- - - [ e—iee] =g
|...1..;_m w Mo lcis olaiie -} e ;
a ~ . -
3 ] L4 - Stress
i ' NUY, |
g . .
» . - ) -
.. -
° Change .
00— ——00.... o0 ——00.,,, . .
. a i ~4000 e
A 12

Fu we | N

J?w

Figure 3-1: Overview of the MyoStrain analysis window
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3.1.1 ANALYSIS WINDOW

Found in the center of the application, this displays the active slice(s) being analyzed. Information about the
currently viewed slice can be adjusted in the upper-left of the image (including heart rate). A drop-down menu is
also used to identify the view for importation into the report. The top area of the Analysis Window has several
options which drive or assist with image analysis. Additionally, located on the right side of the active image is a
color scale used to visualize strain on the image.

3.1.1.1 OVERVIEW

Found in the upper-left hand corner of the Analysis Window, the View Details shows information regarding the
current view and stress analysis stage.

4cH+ 1 ESLV Mode 3 129
E -
.

4" ™
stess 2 . BIS '

8/22,304.5 ms -32%]

o o_u_-o G79‘I5ms

Figure 3-2: 4-Chamber view details (Stress exam)

1. View Dropdown — Contains a list of six possible views analyzable during a MyoStrain analysis.
2. Heart Details (Stress Only) - Users can view and edit the patient’s heart rate directly from this dropdown
menu. Click the circle found below the View Dropdown to access this section.
a. Heart Rate - This value is tracked independently across each slice and stress stage, allowing
manual updates if needed.
b. Stress Agent - Current Stress Stage of the displayed slice.
3. Display Header - Current Analysis tool active. In the example, clicking the mouse anywhere inside the
analysis window will begin drawing an LV contour.
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4. Measurement Scale — This is shown on the left-hand side of the Analysis Window and displays a
reference scale (in cm). This changes size depending on the zoom and acquisition. Disabled by default.

5. Current Timeframe (Current Time) - Shown at the bottom of the image in the lower-left hand corner, this
displays the currently viewed timeframe, the total number of images available in this slice, and the time of
the current timeframe relative to the initial image (in milliseconds). If a mesh is applied to the slice,
timeframes marked in green and underlined are used in strain calculation.

6. Video Playback — Found below the analysis window itself, this shows the current timeframe, and the
timeframes where the End-Systolic and End-Diastolic (LAX views only) meshes are located. More detailed
information can be found in section 3.1.1.4.

7. Strain Scale — Seen on the right-hand side of the displayed image, this shows the range of colors used to
represent the deformation seen in the myocardial tissue.

3.1.1.2 ANALYSIS WINDOW OPTIONS

Displayed at the top of the Analysis Window, the Analysis Window Options are buttons intended to assist the
mesh drawing process. This includes mesh correction tools and visualization enhancements. Most of these
options are also available by clicking the right-mouse button in the active Analysis Window.

L) MyoStrain®Test

File Wiew Help

TR OER O

A B EF

E

%

] K

Change ES  Change ED Swap Accept Mesh

Figure 3-3: Analysis Window options seen during a Stress Exam

A. New Exam — Clicking this will begin the New Exam process. The new exam will only be started once a
dataset has been selected and confirmed. This button will either function identically to the New Exam
From Folder, or New Exam From Worklist option. This can be changed in the View>User Interface
Settings page.

B. LV /RV-These buttons switch between LV analysis and RV analysis modes. The currently active drawing
mode will be highlighted (LV Mode currently enabled in the example).

C. Undo - This reverses the most recent mesh drawing or correction. This button will be greyed-out if no
mesh data is available.

D. Redo - Pressing this will re-apply the most recent action taken by the Undo button.

E. Reset-This resets the image view to its default state. Any image that has been rotated or meshed can be
reset. A notification window will appear to confirm any Reset request. Semi Auto Contouring can be re-
applied if available.

F. Brightness/Contrast — This button is responsible for adjusting the image brightness and contrast for the
current acquisition stage. The adjustment can be done by holding down the left-mouse button and
moving the mouse in the Analysis Window, or by adjusting the sliders in the Analysis Menu.
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G. Zoom - Pressing this button brings up a zoom slider bar. Using this slider, the user can zoom in on the
image, and by using the mouse cursor in the Analysis Window, move the image.

+ Contrast

—»

- Contrast

v

% pBrightness
»

| W R A
Figure 3-4: Holding the left-mouse button and dragging in the shown directions will adjust the brightness and contrast

in the Analysis Menu and vice-versa

H. Noise Filter - Unchecking this box will disable the noise filter. The noise filter by default will ignore signal
intensity under a certain threshold, improving visual quality of the image.

I.  Slice Display Color — Clicking this button will invert the currently active Analysis Window’s background
color. The dropdown menu next to this button also allows for the following:

o  Current Slice — Change only the currently displayed and active slice.
o  All Slices- Change the background color for all slices.

J.  Change ES — Moves the Orange placeholder on the Slice Navigator to its respective location based on the
timeframe when this button is pressed. This timeframe will be used to calculate strain as identified during
End-Systole.

K. Change ED — Moves the Green placeholder on the Slice Navigator to its respective location based on the
timeframe when this button is pressed. This timeframe will be used to calculate global measurements
identified during End-Diastole.

L. Swap - Enabled only when both the ES and ED meshes are available, this will mark the current End Systole
timeframe as End Diastole, and vice-versa. This is useful in case the Diastolic timeframe is drawn first
instead of the Systolic timeframe on a long-axis image.

M. Accept Mesh — Displayed when viewing an un-accepted Semi Auto Contour, clicking this button will set
the mesh as Accepted, and its strain measurements will be reported on.

3.1.1.3 RIGHT-CLICK MENU
Right-clicking anywhere inside the Analysis Window will display a context menu with many of the same features
seen above the Analysis Window, but with a few additional capabilities.
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Figure 3-5: Context menu displayed when right-clicking in Analysis Window

The Right-Click menu can be broken down into 4 groups (from top to bottom):
1. Mesh and Slice Navigation

a. Move to... - Changes the currently displayed slice/timeframe to the listed option.

b. Accept and... - During Semi Auto Contouring, clicking the Accept button will Activate the slice and
convert the recommended contour into a normal contour which will be used for reporting
purposes.

c. Activate/Deactivate — When a slice is active, the strain data from that slice is being used for
reporting purposes. Deactivating that slice will not delete the mesh data, but will not be used.

d. Hide/Unhide — Moves and de-activates a slice while also greying it out to emphasize exclusion.

2. Analysis Mode (Only 1 of these options can be active at a time)

a. LV Mode - Enables LV Analysis mode (RV contours cannot be modified when active)

b. RV Mode- Enables RV Analysis mode (LV contours cannot be modified when active)

c. Brightness/Contrast — Enables Brightness/Contrast adjustment while enabled

d. Zoom —Enables Pan and Zoom adjustment while enabled

3. Mesh Adjustment
a. Undo - Undoes the most recent action
b. Redo - Redoes the most recent action
4. Mesh Removal
a. Remove Epi — Removes the LV epicardial contour from the mesh.
Remove Endo — Removes the LV endocardial contour from the mesh.
Remove Outer RV — Removes the RV epicardial contour from the mesh.
Remove Inner RV — Removes the RV endocardial contour from the mesh.
Remove Mesh — Removes the entire mesh from the image. This does not reset the selected End-
Systolic or End-Diastolic timeframe, only the contours.

P aongoT
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3.1.1.4 VIDEO PLAYBACK (SLICE NAVIGATOR)

Found below the Analysis Window, these buttons will allow the user to navigate between different images in the
current slice.

|1 2 3 5 67 1
oo |£|4 D oe?91.5ms

Spesd J@ ¢
7b Loop 4
7c Display Color ¥

Change ES
7d )

Change EC

Figure 3-6: Slice Navigator shown with the Settings menu expanded
Play/Pause — Begins or pauses video playback.
Back — Moves back one timeframe in the slice
End-Systolic Marker — Shown in Orange, this marks the timeframe being used as End-Systole.
Slice Navigator - Shows the current timeframe, as well as the End Systolic (S) and End Diastolic (D)
timeframes.
End-Diastolic Marker — Shown in Green, this marks the timeframe being used as End-Diastole.
Forward — Advances forward one timeframe in the slice
7. Settings — Additional playback settings can be accessed here.
a. Speed — Change the playback speed to move faster or slower.
b. Loop—When the end of the CINE video has been reached, this determines if the slice will repeat,
other slices in the view will play, or if playback will progress through all slices.
c. Display Color — Changes the background color of the currently displayed image from light to
dark, or vice-versa.
d. Change ES/ED — Sets the current timeframe to End Systole or End Diastole (and copy any
accepted meshes to this timeframe as well)

i

o wu

NOTE: You can also use your mouse’s scroll wheel or your keyboard’s arrow keys to navigate through the images of
the slice, forward and backwards.

3.1.1.5 STRAIN LEGEND

Strain data provides a qualitative color scheme to visualize the contraction strength of the heart muscle. These
color maps are automatically applied to the images being analyzed during the exam. Figure 3-7 provides a basic
guide to the meaning of each color. For more information on Contractility of the myocardium refer to Section 12.2

+5% 0% 5% -10% -15% -20% -25%
Figure 3-7: Color Map Legend

3.1.1.6 WINDOW ADJUSTMENT
The images shown in the Analysis Window can be increased or decreased in size by adjusting the bars seen below
and on the right-hand side of the window. Using the handlebars, left-click and drag the sides of the Analysis
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window to adjust the available area for images to be shown. The image will scale to fit into the largest area
possible while maintaining the images original properties.

3.1.2 IMAGE LIST

Located under the Analysis Window, the Image List displays all images that have been imported by MyoStrain as a
part of the current patient study. These are grouped by slice, time of acquisition, and stress agent (if performing a
stress exam). The bottom row displays all available views in the current stage, while the top row shows all slices
corresponding to the view selected in the bottom row. Each MyoStrain thumbnail is a representative image of
peak strain across all timeframes for that view, and will display the End-Systolic mesh if available.

3CH Average Strain -19.6% B
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Figure 3-8: Image List as seen during a MyoStrain exam with Semi Auto Contouring enabled

A. Active View — All slices labeled with the same view identifier are shown at the top of the Image List when
the corresponding view is selected at the bottom of the Image List.

B. Average Strain (Rest Only) — This shows the Average Peak Strain across all segments of the active slice
(including RV Strain)

C. Active Slice — The currently displayed slice in this view. The active slice is shown at the top with a
highlighted box surrounding it.

D. Active Group — The currently displayed view in the Image List. The active view group is identified with a
highlighted box surrounding it.

E. Inactive Marker — This yellow circle indicates that a slice is available, and a mesh has been created via
Semi Auto Contouring, but has not been accepted. Inactive slices do not provide any strain data or
related measurements to the report.

F. Active Marker — This green circle indicates that a slice is analyzed and is active. Measurements from
active slices are being utilized in the MyoStrain report.

G. Timeframe Marker — This identifies the End Systolic timeframe in the slice (red is inactive and black is
active in Light Mode)

H. Relative Plane — This black line (orange when displayed in Dark Mode) shows the relative plane of the
current selected slice (the slice outlined in Red), respective to the displayed slice.

I.  Stress Agent — This dropdown menu is used to identify the stress agent used in this series. Adjusting this
menu will change the label of the stressor used in this study.

J.  Acquisition Group — This dropdown menu switches between other stress stages available in the study. By
default, the last acquisition in the group is displayed as the default stress agent being compared against.
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NOTE: If multiple slices are available under a single view, the Semi Auto Contouring tool will attempt to analyze all
of them. Semi Auto Contouring will calculate peak strain from each slice and mark its recommendation of the best
slice with an inactive marker. Any meshes drawn using Semi Auto Contouring must be reviewed and activated
before strain calculations will be used for reporting purposes.

3.1.2.1 STRESS AGENTS AND ACQUISITION

During a stress examination, two dropdown menus will appear below the Stress Image List (the group of images
on the right-hand side of the Stress Analysis page). The menu on the left identifies the Stress Agent being used for
this series of images. Modifying this dropdown will change the label, not the series of images being displayed as
the Stress images. The menu on the right lists every series of images (Acquisitions) associated with this study,
except for Acquisition 1 which defaults to Rest.

Figure 3-9: Stress Phase dropdown menu seen during Stress exam

NOTE: Any changes to the image made in the Analysis Window are also applied in the Image List. This includes
brightness/contrast changes and drawn meshes.

3.1.2.2 RIGHT-CLICK MENU

Right-clicking a thumbnail inside the Image List will display a different context menu than the one seen in the
Analysis Window. These are useful for toggling between two different slices of the same view to identify
differences between them, and to quickly view or hide images.

E Select

\' Deactivate
| Hide

o |

Rest 4 MyoHealth Score: -- % Acquisition 1

Figure 3-10: In the Image List, green radio buttons mark the slices being reported

e Select - Displays the selected slice in the Analysis Window
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e Hide - Greys out the selected slice and pushes it to the end of the current stage in the Image List

e Unhide - Activates a slice which has been previously hidden

e Activate - Enables the selected slice and sets it as active with the Green radio button

o Deactivate — Disables the selected slice. Mesh data is not removed, but measurements are not being
pulled from this slice for strain reporting.

2CH 2CH Average Strain -23.2%
. U ad i

Figure 3-11: Image List with 2 slices hidden from the report

3.1.2.3 IMAGE LIST ADJUSTMENT

The size of the images shown in the Image List can be increased or decreased in size by using the blue handlebars
seen underneath each stage of images available.

' ICH Average Stzan -24.3%
’
*

MM!‘.« LoD Acquisition 1
Figure 3-12: Increasing the size of the Resting stage image list.

3.1.3 ANALYSIS INFORMATION AND PROGRESS

The right-hand side of the Analysis window provides information regarding the current analysis. This includes
analysis progress, patient information, AHA models, and a notes section which is carried over across the different
modules of the application as well as on reported information collected during the analysis.
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Figure 3-13 — Overall information about the current exam is shown on the right-hand side of MyoStrain

A. Exam License Information — Provides information about the remaining exam licenses available to the

workstation. Shows the overall number of Strain/Stress remaining, then the number of exams expiring

next, along with the number of days remaining for those exams.

About Menu- Clicking on this icon displays the About menu.

C. Patient Information — General information regarding the patient being analyzed. This data is
automatically populated from data available on the DICOM images used to store the SENC image data.

D. Additional Information — More details regarding the currently displayed patient’s information is available
by clicking on the | icon shown here.

w
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E. AHA Models — Displays strain data in a visual format. Hovering over a segment will display the numerical
strain value for that segment.

F. Checklist — This provides a visual checklist of the expected contours for a strain or stress exam. When a
contour has been completed, a checkmark is placed in the appropriate box, and changes color when
completed.

G. Notes — This section is a freeform textbox where any findings or notes relevant to the current analysis
should be written. These notes are carried across the application and included in the reports exported at
the end of the analysis.

H. Export Buttons

1. Export to PACS — Begins the export process, with MyoStrain formatted images being created for
export to a networked location for archival.

2. Export to PDF — Begins the export process for the MyoStrain report. This is a local copy of the
MyoStrain report, which can be viewed in the Report tab as well.

3.1.3.1 LICENSE AND EXAM CREDIT INFORMATION

MyoStrain is governed by the license information provided on activation. Information about the existing license
can be seen in the upper-right hand corner of the screen and can be detailed by clicking the Myocardial Solutions
logo found below the X of the application window. The license can also be viewed and updated from this menu.

The number of remaining exams is shown in the title bar next to the Myocardial Solutions logo. The title bar will
change color to alert the user when the license is close to expiration. Options in the User Interface Settings menu
will allow the user to define how this title bar behaves. By default, the warnings are displayed as follows:

e Yellow- 30 or fewer days remaining, or 10 or less Strain/Stress exams.
e Red - Fewer than 5 Strain/Stress exams.

Simply opening MyoStrain will not consume an exam credit. Re-opening an older exam will also not consume an
exam credit. Whenever images are received by the MyoStrain application as part of a new exam, an exam credit
will be consumed.

— x>
49 Strain, 50 Stress (49, 50) expire in 365 day(s) ([REorder) -

Figure 3-14: Yellow caution warning

— x

2 Strain, 2 Stress (2, 2) expire in 365 day(s)

Figure 3-15: Red alert warning

Clicking on the Reorder button will launch the Reorder form and launch the Self-Check program as well. These
warnings can be modified from the User Interface Settings menu under the Alerts tab (Section Error! Reference
source not found.).

3.2 THE MYOHEALTH® REVIEW TAB

Whenever a previously analyzed dataset is opened in MyoStrain for review (or whenever the MyoHealth® Review
button is clicked), the MyoHealth Review interface presents more detailed information gathered during the
analysis. These measurements, such as Traditional Global Measurements, are available to the analyst during the
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analysis but are not necessary to conduct an accurate analysis of the MyoStrain SENC images. Additional
visualization features such as Polar Plots and the 3D Model can also be viewed here.

- - [ R (n- 12

Rest: Longitudnal

Stre<s, Longituding!

LB M A HEETLMTSATS
Cucumferental

oQ

00— 0@ _

|Rest: Crcumlerential

o0

Strass: Croumferential

Figure 3-16: Overview of the MyoHealth® Review tab during a Stress exam.

More detailed information regarding the MyoHealth® Review tab can be found in Chapter 11.

3.3 THE MYOSTRAIN REPORT TAB

The Report tab is the 3" window of the MyoStrain software, which shows the information collected during the
analysis in an easy to read and interpret report. The information shown here is identical to the report exported as
a PDF using the Report to PDF feature and included as part of the default DICOM series sent back to PACS as part

of a typical analysis protocol.

LV Myoties™ 88 %

AV Myatiertt™ 10 % mm e AP

Figure 3-17: Layout of the Report section during Stress Mode
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Additionally, the report can be viewed simultaneously during the analysis as a pop-out window. Clicking the pop-
out icon in the Report button will separate the report and make it viewable when using the Analysis or MyoHealth
Review tab. More information about the report can be found in Chapter 7.

NOTE: Some derived calculations will not appear on the pop-out version of the MyoStrain/MyoStress report. The
Timing Metrics group is not displayed on the pop-out but is available in the Report section itself.

3.4 LICENSE AND EXAM CREDIT INFORMATION

MyoStrain is governed by the license information provided on activation. Information about the existing license
can be seen in the upper-right hand corner of the screen and can be detailed by clicking the Myocardial Solutions
logo found below the X of the application window. The license can also be viewed and updated from this menu.

— ot
50 Strain, 50 Stress (30, 50) expire in 365 day(s) r\_,«

Figure 3-18: Software license with 50 Stress and 50 Strain exams left that expire in 1 year.

3.5 APPLICATION TOP LEVEL MENUS

The File menu in the upper-left hand corner of the program provides a few options focused on managing exam
data. This is intended for revisiting a previously performed exam, or to close/save a current exam. Each entry
labeled with a * will consume an exam credit when successfully run. The options for the File menu are as follows:

e New Exam*- Clears all data currently loaded into the MyoStrain application and displays the Select Your
Exam screen.

e New Exam from Worklist* - Opens an in-application version of the MyoWorklist to create new exams.

e New Exam from Folder* — Opens a file navigation window which imports all images contained in a folder.
MyoStrain will attempt to organize the data based on information available in the DICOM header (data
will be organized based on Stress Stage and view)

e  Open Analyzed Exam - Opens a file navigation window to open an old exam.

e Open Recently Analyzed Exams — Displays a list of up to 10 previously performed exams

e Export-

o Export Anonymous - Exports an anonymized copy of all available measurements, reports, and
images from the current analysis.

o Export Data - Exports a .csv or .xml file containing all raw strain values from all stress levels
recorded during the exam. Please refer to section 7.6.3 for more details regarding saving this
file.

o Export to DICOM - Exports a copy of all data specified in the Export to DICOM Settings menu to a
local folder. The data is exported in DICOM format, which can be viewed with a DICOM viewer
or stored in PACS manually. Refer to section 3.5.5 for more information on what is exported.

o Export to PACS - Pushes a copy of all the data specified in the Export to DICOM Settings menu to
a selected PACS server. Configured servers will appear in a nested menu when selected. Refer to
section 3.5.5 for more information on what is exported.

o Report to PDF - Exports a .pdf file containing the Report. The Stress Report will also contain a
copy of the Strain report. Please refer to section 7.6.3 for more details regarding saving this file.

o Image -
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=  Analysis - Exports an image capture of the currently displayed image in the Analysis
Window. Adjustments to the image created can be done through the Image and Video
Settings option in the Setup Menu.

= 3D Model - Available on the MyoHealth Review tab, this exports images of each
version of the 3D model at systole. A folder is created containing the JPG formatted
images in the location selected.

=  Polar Plots - Available on the MyoHealth Review tab, this exports an image of all
available versions of the polar plots at the current timeframe (Defaults to Systole). A
folder is created in the selected path to store these JPG format images.

o Video -

=  Analysis - Exports a video of the currently displayed slice in the Analysis Window.
Adjustments to the video created can be done through the Image and Video Settings
option in the Setup Menu

= 3D Model - Exports a video of each available 3D model from beginning to end into a
folder specified in the export menu.

= Polar Plots - Exports a video of each polar plot view into a folder specified in the export
menu.

e Rename Exam - Changes the default name of the exam displayed in the title bar, as well as the exam data
folder created during the study. Note: Renaming an exam may not automatically update the file export
path, double-check where data is being exported before doing so

e Save Exam — Saves the current exam.

e Close Exam — Saves, then closes the current exam. This clears all data currently loaded into MyoStrain.

e Reorder — Opens a pop-up menu which will begin the Reorder process. Please note that launching this
feature will require the self-check to run, which may take a few minutes to complete.

e Show Exam Licenses — Opens a pop-up menu which displays all active MyoStrain exam licenses.

e Setup -

o Local Export Settings — Opens the Local Export Settings submenu. Please refer to section 3.5.4
for more detailed information.
o DICOM Export Settings — Opens the DICOM Export Settings submenu. Please refer to section
3.5.5 for more information.
o Application Settings
= Self-Check - Starts the Self-Check. Please visit section 2.2.1 for more information.
= Analysis Settings — Launches the User Interface Settings in the Workflow tab, which will
modify how MyoStrain analyzes images.

e  Exit — Closes the program. MyoStrain will save any changes made to the currently opened exam, then
close the Analysis Window. If the Dicomizer program is running, it will close after the dataset being
processed is complete. Clicking the X in the upper-right corner of MyoStrain will perform the same action.

NOTE: The exam data file is a single DICOM image which contains information related to exam inside the DICOM
header for RIS and external PACS applications.

3.5.1 OPEN ANALYZED EXAM
MyoStrain is backwards compatible with exams created in MyoStrain starting with version 5.2.4. Opening an old
exam will not consume an exam credit. Once opened, an exam is editable and fully modifiable.

NOTE: Modifications to exams imported from older versions of MyoStrain should be reviewed for mesh
completeness before exporting exam information.
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3.5.2 OPEN RECENTLY ANALYZED EXAM
MyoStrain keeps track of the 10 most recently analyzed exams in a list under this File menu option. Clicking on any
of these entries will open that analysis. This action does not consume an exam credit.

\J MyoStrain®Test[Philips_PT1_20201022 9]

File View Help

New Exam Ctrl+N @U ;(-_: A@m‘@

New Exam from Worklist
New Exam from Folder ES LV Moc

Open Analyzed Exam...

hOpen Recently Analyzed Exams * | 1 _ gireccExam
Export »| 2- Philips_PT1_20201022_8
Rename Exam 3 - 8675309001_20160726_7
Save Exam 4 - Philips_PT1_20201022_6
Close Exam Cuiex | 5-MR_20160919

6 - Philips_PT1.20201022

Heogdes 7 - 8675309001_20160726_2
Show Exam Licenses 8 - 8675309001_20160726

Setup 4
Exit Alt+F4

Figure 3-19: Recently Analyzed exams list

3.5.3 SHOW EXAM LICENSES
In addition to the title bar, exam license information can also be viewed using this option from the File menu.

(. Exam Licenses — O =

Start Date Expiration Date Strain exams left Stress exams left Remaining Day(s) Confirmation Code
2020-01-20|2021-01-20 47 44 365 Mxik
2020-01-21|2021-07-21 25 25 547 22bw

Figure 3-20: Exam Licenses added to MyoStrain with their expirations

Each software license runs independently, and MyoStrain will pull exams from the license code that is scheduled to
expire first. License codes which have expired will not be displayed in this list.

3.5.4 LOCAL EXPORT SETTINGS

The Local Export Settings menu found in the File>Setup menu contains three menus of options that changes how
MyoStrain exports data for use outside of the application on the local workstation. These settings can also be
updated when exporting a video or screenshot by pressing the Show Advanced Settings button seen in Figure
3-22.
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.,' Local Export Settings

elling Display ES Mesh Display Timeframes
Midag Display ED Mesh Display Strain Palette
Geners] Display Slice ID [ pisplay HR

Slices to be Exported

® Current Slice O all Active slices

[ override Application Settings

Background Color Light Maode

[ Display Scale

Figure 3-21: Default Video/Screenshot export settings

' N
(. Export Video @

Choose folder CAUsers\WMTest\Desktop\FolderName E]
File name Myo\-"ided
Show advanced settings ] Save l [ Cancel ]

Figure 3-22: Video Export dialog box

Exported videos and screenshots will be exporting using the settings found in the Video and Still Img tabs
respectively. The General export settings change how data files are exported.

e Still Img And Video
o Display ES Mesh — When checked, the mesh drawn at End-Systole will be included in the output.
o Display ED Mesh - When checked, the mesh drawn at End-Diastole will be included in the output.
o Display Slice ID - Hides or displays the view information typically seen in the upper-left corner of
the Analysis Window.
o Display Timeframes - Enables or disables the phase/timeframe counter in the lower-left corner
of the active slice.
o Display Strain Palette — Hides or shows the strain scale and legend on the right side of the
analysis window.
o Display HR — The Heart Rate can also be included or excluded from video/image output.
o Slices to be Exported
= Current Slice — Only export the displayed slices.
= All Active Slices — Export all active slices (green radio button icon)
o Override Application Settings — When enabled, images and video exported will use these
settings instead of what MyoStrain is currently displaying.
= Background Color - sets the default background color of slices/images exported from
MyoStrain.
=  Display Scale - This manages whether the measurement scale shown on the left side of
the image will be included.
e Video Menu
o Video Encoding/Container— Changes the format which MyoStrain will export videos.
o Override Application Settings
=  Default Speed — When enabled, the default playback speed of the videos exported will
use this speed instead of what’s being used in MyoStrain currently.
e General
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o CSV Delimiter — Changes the token used to separate values in CSV documents exported by
MyoStrain. Defaults to comma.

.,' Local Export Settings

Stillimg | coy pelimiter | comma v
Video

General

(o | [Lom ]

Figure 3-23: General tab of the Local Export Settings menu

3.5.5 DICOM EXPORT SETTINGS

The DICOM Export Settings menu found in the File>Setup menu allows changes to what information is exported
from MyoStrain when DICOM images are requested. This affects images exported to PACS, or images exported to
the local machine using the File>Export>Export to DICOM feature.

i} DICOM Export Settings

You must select at least one option.
Images and PDF Report
Export Only Active Slices
Images Background Color Light Mode -
Report Data
Exam File
3D Model
Polar Plot
Dicom SR
Compression Techniques JPEG Compression .

Figure 3-24: DICOM Export Settings Menu
1. Images and PDF Report — This enables/disables the MyoStrain/MyoStress report as well as the MyoStrain
formatted images with contours.

a. Export Only Active Slices — With this enabled, only the slices which are being reported on in the
MyoStrain/MyoStress report are exported to DICOM.

b. Images Background Color — This sets the background color of MyoStrain formatted images sent
to DICOM. By default, all MyoStrain images are archived with a light background (regardless of
application display mode).

2. Report Data - When enabled, this sends a DICOM file with all measurements and other reported data
stored in the DICOM header using Myocardial Solutions Private DICOM tags.

3. Exam File — Sends a copy of the exam file (.myo) wrapped in a DICOM file for storage on PACS or disk.
When sent to the MyoStrain workstation through the Worklist, the exam file is recreated.

4. 3D Model - Shows the heart at the systolic timeframe rotated around the central axis, with snapshots
taken at 15-degree intervals.

5. Polar Plots - Shows the polar plot model available at all timeframes for each stage and strain orientation.
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6. Dicom SR —When enabled, this generates a structured DICOM report, which is separate from the
MyoStrain/MyoStress report. This is generally used for automation and clinical reporting purposes.
7. Compression Techniques — This changes how images sent from MyoStrain to a networked node are
compressed. Below are the options available and their associated transfer syntax (0002,0010)
a. JPEG Compression —1.2.840.10008.1.2.4.50 (JPEGBaseline)
b. RLE Compression —1.2.840.10008.1.2.5 (RLELossless)
c. Nocompression —1.2.840.10008.1.2 (ImplicitVRLittleEndian)

3.5.6 ANALYSIS/USER INTERFACE SETTINGS MENU

The Settings menu found in the File>Setup menu (and also in View>User Interface Settings) contains options that
allows users to customize how MyoStrain displays data. Pressing the Save button in the lower-right hand corner of
the window will save any modifications made. This menu contains 5 submenus with different controls in each.

er Interface Settings

Enhance Traditional Measurement Calculation
Alerts
Mesh . .
Semi Auto Contouring
Report
Move Hidden Slices
Thumbnail Slice Order (8) BMA242 ) Scan Order

e (e

Figure 3-25: User Interface Settings menu found in MyoStrain’s File menu

o  Workflow Tab
o Traditional Measurement Calculation — Enables or disables the collection of “Traditional
Measurements” in reporting. With this option off, End Diastolic meshes can no longer be drawn,
and measurements such as “LVEF” and “LV Stroke Volume” will be disabled.
o Semi Auto Contouring - Enables or Disables Semi Auto Contouring. Please refer to section 9 for
more information.
o Move Hidden Slices - Enabled by default, any image in the Image List which was manually hidden
will be pushed to the end of the list. When disabled, hidden images will be shown as greyed out.
o  Thumbnail Slice Order — Changes the order in which the thumbnails in the Image List are
displayed.
=  BMAS342 - Displays images in the following order: SAX Basal, SAX Mid, and SAX Apical,
followed by LAX 3Ch, LAX 4Ch, and LAX 2Ch. Same order as displayed in the report.
= Scan Order - Displays images based on the order in which they were generated by the
MRI scanner. Earliest scans are displayed first.
e Enhance Tab
o New Exam Default — Changes the behavior of the New Exam button seen in the upper-right
corner of the Analysis page.
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=  From Folder — Will display the “New Exam From Folder” dialog box when the New Exam
button is pressed.

=  From Worklist — Will display the MyoWorklist inside MyoStrain, and new exams can be
previewed and launched from there.

o Analysis Window Background — Switches the Analysis Window to display with a white
background (default), or a dark background. This does not affect the rest of the application, just
the window where MyoStrain images are displayed.

o Display Relative Planes — Enable or disable the display of the reference plane shown on
thumbnails when a slice is active in the Analysis Window.

o Display Scale - Enables or disables the measurement scale shown on the left-hand side of the
Analysis Window

o Display Header- Current analysis tool active, or the next step in the SAC analysis process.

o Brightness Contrast Defaults — This sets the default brightness/contrast values when importing a
dataset. Defaults can be set for both the dark and light analysis window backgrounds.

o Application Display Mode — This dropdown changes the background color schema of MyoStrain
to either Dark mode or Light mode.

e Alerts Tab

o Exam Countdown Warning Number - If either the strain or stress exam count drops below the
specified values, the Exam Countdown seen in the upper-right corner of MyoStrain will display
Yellow.

o Exam Countdown Risk Number — If either the strain or stress exam count drops below the
specified values, the Exam Countdown in the upper-right corner of MyoStrain will display Red.

o Application Expiration Warning — If the application license expires within the specified number
of days, a warning pop-up will display each time MyoStrain is launched.

e MeshTab

o Enable Custom Mesh Settings — Off by default, enabling this will change the way meshes are
displayed to the end-user.

o Mesh Transparency — The lower the value, the more transparent the mesh will display. No mesh
transparency is enabled by default.

o Mesh Point Thickness — Adjusts the thickness of the individual pins on each contour.

o Mesh Line Thickness - Adjusts the thickness of the lines between each pin on each contour.

o Mesh Color Selection — Allows for the customization of mesh colors for Light and Dark analysis

background colors.

= Mesh Color (A) — Color of the lines defining the epicardium and endocardium. When
the LV contour is active, the RV will appear inactive, and vice-versa.

= |nactive Mesh Color (B) — Color of contours which cannot be modified

= Points (C) — Color of the pins surrounding the myocardium, this also includes the
handlebar in the center of the blood pool.

= Reference Marker (D) (SAX Only)- Marks the location of the LV RV Anteroseptal
junction. This marker only appears on Short-Axis images.

= Apex Marker (E) (LAX Only) — Marks the location of the apex point on a Long-Axis
image. This point only appears on Long-Axis images.
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Figure 3-26- Mesh Color customization references during Analysis
e Report

o Report Type — Changes the display of the default Long-Axis models shown in the Report Tab and
MyoHealth Review tab.

o Report Logo — A custom logo can be applied to the upper-right corner of the PDF report
generated by MyoStrain. This logo is included on any reports created by MyoStrain.

o Exported Report Template — The layout of the PDF report can be changed to one of several
defaults. Examples of these layouts can be found in section 3.5.9

3.5.7 REPORT TYPE

By default, MyoStrain displays Long-Axis images in the 3/4/2 Chamber View model. If an Analyst or Reviewer
wishes to display the Long-Axis data in the same way Short-Axis data is shown, the Bullseye Plots option should be
selected from the Report Type dropdown menu. This option will not affect the Analysis tab’s layout.

RV LV

4CH
BAL

3CH

4CH e

RVBL 2CH B

Figure 3-27: The Bullseye Plots display option shown in the User Interface for Report and MyoHealth Review
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3.5.8 REPORT LOGO
This sub-section allows customization of the MyoStrain/MyoStress report. Using the Browse button, a .jpg or .png
logo can be imported and displayed in the upper-right corner of the report.

o User Interface Setings

Woerkdlow Report Logo
Enhance
Alerts

Mesh

Hospital/

OPIC Name

Mucmium ¥iownd Sz 25004 X 60p%) | ] l Browse |

Seve Canced

Figure 3-28: Logo selected for use with the MyoStrain report

After the logo has been uploaded, click the Save button to finalize the changes. The logo will appear in the upper-
right corner on all pages of the report created at the end of MyoStrain analysis.

NOTE: Images which do not fit the 250x60 pixel window will be resized proportionally to fit in the allotted window.

@ MyoStrain’ MyoStrain® Test Results o'l?é"ll"’n'fe

Cardiac Prevention Center

Patient ptl Accesslon #:
Figure 3-29:Example image of the top of a MyoStrain report with a custom logo

3.5.9 EXPORTED REPORT TEMPLATE

In MyoStrain 6.1, there are a total of 2 different layouts for the exported PDF report (in addition to the
customizable Report Logo). This template will be used for the MyoStrain/MyoStress report exported via DICOM,
as well as the PDF paper copy. The version used in this manual is the application default (aside from below). The
measurements displayed between each report type are the same; just the layout and positions are modified.
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Figure 3-30: Non-Default (Template 1) MyoStress report layout available for export

3.5.10 VIEW MENU

Next to the File menu at the top of the MyoStrain application, another menu labeled View is available.

MyoStrain ® Test[Philips_PT1_20201022]

File  Wiew Help

User Interface Settings

M
E Reset Window Layout

Dicomizer

J

Figure 3-31- View Menu

e User Interface Settings — See section Error! Reference source not found. for more information, this menu

links to the Enhance tab of the User Interface Settings menu.

e Reset Window Layout - Resets the User Interface (GUI) to its default settings.
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e Dicomizer — Launches a separate window which tracks the upload progress of datasets being sent to PACS
or other systems for archival or reporting purposes.

3.5.11 HELP MENU
Rounding out the 3 top level menu items of MyoStrain, the Help menu provides useful information about the
application (such as the license and expiration dates).

L MyoStrain @ Test[Exam_9]

File View | Help

| New Ex: About MyoStrain

Amalysis Hotkeys

User Documentation

Figure 3-32: Help Menu displayed

e  About MyoStrain — Displays the About menu (Figure 2-19)
e Analysis Hotkeys — Displays a list of quick reference keyboard hotkeys which can assist with analysis
o CTRL+Q - Toggle between light-mode and dark-mode in the analysis window.

CTRL+R - Toggle between LV and RV analysis modes

CTRL+S - Set current timeframe as End-Systole

CTRL+D - Set current timeframe as End-Diastole

CTRL+Z - Undo most recent action

CTRL+Y — Redo most recent action

CTRL+(+) — Zoom-in

CTRL+(-) - Zoom-out

CTRL+ScrollWheel — Zoom in/out

CTRL+Shift+ScrollWheel — Pan image in Analysis Window

Spacebar — Start/Stop CINE playback

CTRL - Force Default cursor (Analysis mode mesh application tool)

ENTER — Accept SAC recommended mesh

e User Documentation — Displays a pop-up window with links to the User’s Manual in addition to Video
Tutorials which provide a visual demonstration of selected features in MyoStrain.

O 0O 0 0O 0O O O O O O O O

MpaSuan Users Mawis - 11y

Video Tiarb

Figure 3-33: User Documentation Pop-up menu with links to video tutorials
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3.6 APPLICATION WINDOW ADJUSTMENT

Portions of the MyoStrain application can be resized using the blue dividers seen throughout the program window.
To increase or decrease the size of the Image List, Analysis Window, Patient Information or Findings sections,
simply left-click and hold the 5 dots seen in the middle of the divider (Figure 3-34), then drag the divider to the
desired location. The Analysis Window will automatically increase the size of the images being viewed to fill in as

much available space as possible.

LOO ; 0

.'/J’;-
0_

10022, 373.5 118
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Figure 3-34: Resizing the Analysis Window by decreasing the size of the Image List
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4. IMAGE QUANTIFICATION

This chapter provides a detailed walkthrough of the MyoStrain image quantification process. The procedure for
measuring and quantifying strain on each view of the myocardium is the same between Strain and Stress exams.
Please refer to Sections 5 and 6 for Strain and Stress exam workflow respectively.

Upon opening SENC formatted images from the MR scanner, MyoStrain will display colorized images of the
patient’s heart. These colors (shown in the color scale Strain Legend) represent the amount of motion (strain)
measured at any given point of the myocardium. MyoStrain requires the user to identify/verify the current view
and apply a mesh to the left ventricle near end systole to accurately measure peak myocardial strain. Additionally,
traditional measurements can also be gathered using the same tool.

Use of Semi Auto Contouring will be covered in Chapter 9. It is imperative that each image is reviewed prior to
applying or approving meshes to ensure accuracy in the analysis.

NOTE: When computing the strain after contouring the heart with a mesh, the strain measurements are confined
within the mesh and several timeframes before and after the meshed timeframe. Timeframes used in mesh
calculation are underlined and highlighted in green in the lower-right corner of the Viewing Window.

4.1 DRAWING THE LV MESH (SHORT-AXIS VIEWS)
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Figure 4-1: MyoStrain exam with three Short-Axis and three Long-Axis slices

To draw a short-axis mesh, select one slice in the Image List which shows a Basal, Mid, or Apical view.

1.
The bottom row of the Image List shows all available views, the top row shows all available slices

a.
for the selected view.

In the upper-left hand corner of the Analysis Window, use the View Dropdown menu to select what view is
currently displayed. This will set the report to display the data gathered from the mesh in the correct location

2.
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Figure 4-2: Selecting the appropriate view from the View Dropdown

3. Just below the View Dropdown menu is a second dropdown menu which tracks the patient’s Heart Rate. This
can be updated manually in cases where the heart rate was not read correctly.

4. If the image itself is too small, use the handlebars found on the right-hand side of the Analysis Menu and
above the Image List to increase the size of the Analysis Window itself.

4.1.1 EPICARDIAL CONTOUR

1. Using either the CINE viewing buttons at the bottom of the image, your mouse scroll wheel, keyboard arrow
keys, or the Slice Navigator, navigate through the slice to visually identify which image corresponds the most
to end-systole.

2. Starting at the RV insertion point (anteroseptal), use your mouse to make at least 4 points clockwise around
the epicardial contour by left-clicking the myocardial border and ending on the Inferoseptal RV insertion point.
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Figure 4-3: Beginning drawing the epicardial contour
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Figure 4-4: Double-clicking here will complete the epicardial contour
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3. Double-click the last point of the contour near the starting contour point to complete the drawing.

4. A contour polygon will be created for the epicardium defining several points. The first point created will mark
the RV connection point.
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Figure 4-5: Completed epicardial contour

NOTE: Meshes can also be applied by tracing the epicardium while holding down the left-mouse button. Releasing
the left-mouse button will complete the drawing.

4.1.2 LV MESH COMPLETION (ENDOCARDIAL CONTOUR)
Using the same drawing method, define the endocardial contour. Since the epicardial contour marks the position
of relevant anatomical markers, the endocardial contour can be applied beginning at any point.

NOTE: Papillary muscles should be omitted from any contours.
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Figure 4-6: Completing the endocardial contour and the finished mesh with RV marker
After the endocardial contour has been added to the mesh, the MyoStrain software will zoom into the image and
improve visibility. Ensure that the corresponding Short-Axis model in the Measures section is updated after
finishing the mesh.

4.1.3 ADJUSTING THE MESH (SHORT-AXIS VIEW)
Once the mesh is applied, changes or updates to the mesh may be required. Common changes may be to adjust
the location of the RV insertion point, or to adjust a minor region of an epicardial contour.

1. The blue arrow should be marking the RV insertion point (anteroseptal, outside of RV blood pool) .

2. You can rotate the mesh by clicking and holding the insertion point arrow and moving it to its appropriate
location.

3. Ifany individual points need to be moved to better fit the myocardium, use your left-mouse button to
reposition points on the mesh.

.

Figure 4-7: Example of a single_point mesh correction
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4. |If alarge section of the mesh’s epicardial or endocardial contour points need to be redrawn, you may redraw a
portion of the contour by left-clicking periodically near the existing mesh, then double-clicking to complete.

Additionally, clicking and holding the left-mouse button will allow a contour to be traced onto the
myocardium. The mesh will incorporate this new drawing into the existing mesh. (Figure 4-8).

5. If the mesh has been placed in an incorrect location after image rotation, the red dot shown in the center of

the LV blood pool can be used to drag the mesh into a different location.

6. The Undo, Redo, and Reset buttons found in the Slice submenu will undo the most recent mesh action, redo

the most recent mesh action, and reset the slice to its default state respectively.

Mid ES LV Mage 12988 Mid ES LV Mode

v

- -n

9/25 3565 ms -32 9/25 3565 ms

’
Ao

Figure 4-8: Mesh adjustment by drawing a new contour freehanded

4.1.4 RV QUANTIFICATION (SA BASAL AND SA MID)

After completing the LV mesh, the RV can be measured by adding additional contours to the existing LV mesh.
Please note that Short-Axis RV quantification can only be performed on the Basal and Midcavity slices of the stack.
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Figure 4-9: Clicking on the RV button after completing the LV mesh will enable RV contouring

First, enable the RV analysis tool by pressing the RV button at the top of the Analysis Menu (Figure 4-9). Then,
starting at the RV anterior junction, use your mouse to identify the epicardial boundary of the RV wall. Left-
clicking first on the RV anterior junction, click multiple times on the epicardial wall moving counter-clockwise,
making the last point touch on the RV Inferoseptal junction. Double-clicking on the RV Inferoseptal junction will
complete the contour on the RV and will attach itself to the existing epicardial LV contour.

NOTE: You can switch to RV analysis mode by pressing CTRL+R on your keyboard, or by right-clicking the Analysis
Window and selecting RV Mode.
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Figure 4-11: Double-clicking here will complete the epicardial RV contour

NOTE: You can also click and hold down the left-mouse button to draw a contour by tracing the epicardium or
endocardium.
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Figure 4-12: Completed RV epicardial contour

Using the same method as before, define the endocardial contour. Once complete, the RV mesh will be fully
attached to the existing LV mesh, and measurements from the RV will be displayed in the Report.
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Figure 4-13: Defining the endocardial contour for a complete RV mesh

If adjustments need to be made to the mesh during or after completion, click the Undo button to erase the

contour or mesh to try again.
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4.2 DRAWING THE MESH (LONG-AXIS VIEWS)

1. Todraw along-axis mesh, select one slice in the Image List which shows a 2-chamber, 3-chamber, or 4-
chamber view of the myocardium.

2. Inthe upper-left hand corner of the Analysis Window, use the View Dropdown menu to select what view is
currently displayed. This will set the report to display the data gathered from the mesh in the correct location.

4CH LV Mode
Basal

Mid
Apical
2CH

3CH
acH 1y

Unknown

e
7/25, 2828 ms

Figure 4-14: Selecting a Long-Axis view from the View Dropdown menu

3. Inthe upper-left hand corner of the Analysis Window, enter or update the patient’s heart rate in the textbox
below the view selector.

4.2.1 EPICARDIAL AND ENDOCARDIAL LV CONTOURS

1. Using the video playback buttons at the bottom of the image, your scroll wheel, or the Slice Navigator, look
through the slice to visually identify which image displays best represents end-systole.

2. Starting on either side of the LV, use your mouse to make points around the epicardial contour by left-clicking
periodically on the image. A minimum of 4 points must be used to draw this contour.
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Figure 4-15: Beginning the epicardial contour
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Figure 4-16: Double-clicking here will finish the epicardial contour

Double-click on the last point.
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4.

5.

A mesh contour will be created for the epicardium. Ensure that the red circle is at the apical point of the LV. If

this circle is not correctly positioned, use the left-mouse button to drag it into the appropriate location.

Changn £5

c0— 00,

Figure 4-17: Completed epicardial contour with correct apical marker

Using the same method, draw the endocardial contour (avoiding the papillary muscles). Upon completion, the
image will rotate to match the models shown in the Measures section. Additionally, a red dot will appear near

the middle of the LV blood pool.
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Figure 4-18: A completed epicardial contour with apical marker.
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4.2.2 ADJUSTING THE MESH (LONG-AXIS VIEWS)

After completing the mesh, adjustments may need to be made to accurately represent the myocardium. Common
adjustments may involve redrawing one section of the contour or resetting the reference point shown on the

image.

1. Depending on where the final contour drawing of the mesh began will determine where the reference
marker is shown on the image. If this reference marker is incorrect, left-clicking on these letters will
switch the reference point to the corresponding side.

e  BAL - Basal Anterolateral (4ch)
e  BIS—Basal Inferoseptal (4ch)
BAS — Basal Anteroseptal (3ch)
BIL — Basal Inferolateral (3ch)
BA — Basal Anterior (2ch)

Bl — Basal Inferior (2ch)

Figure 4-19: The mouse cursor will change when hovering over the reference point. Left-clicking will flip the image and change
the reference marker.

2. If any individual points need to be moved to better fit the myocardium, use your left-mouse button to
reposition points on the mesh.

Figure 4-20: Example of a single point mesh correction
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3. If alarge section of the mesh’s epicardial or endocardial contour points need to be redrawn, you may redraw a
portion of the contour by left-clicking periodically near the existing mesh. Double-clicking at the end of this
correction will signal the completion of the new contour and will be incorporated into the existing mesh
(Figure 4-21).

4. If the mesh has been placed in an incorrect location after image rotation, the red dot shown in the center of
the LV blood pool can be used to drag the mesh into a different location.

5. If either the endocardial or epicardial contour needs to be moved, click and drag any of the lines of the
contour to relocate the drawing.

6. The Undo, Redo, and Reset buttons found in the Slice submenu will undo the most recent mesh action, redo
the most recent mesh action, and reset the slice to its default state respectively.

ES LV Mode 12%

4CH ES LV Mode
.

25. 282.5 ms

-32%

2
e

Figure 4-21: Modifying the mesh by redrawing a contour section using the freehand method

After drawing and correcting the mesh, verify that the information displayed in the Circumferential Strain
subsection of Measures reflects the data shown in the Analysis Window.

4.2.3 LONG-AXIS RV QUANTIFICATION

After completing the LV mesh, the RV can be measured by adding additional contours to the existing LV mesh.
Please note that Long-Axis RV quantification can only be performed on the 3 and 4-chamber views of the LV. Make
sure the RV button is selected (Figure 4-22) in the Analysis Menu before applying an RV contour.

NOTE: You can also click and hold down the left-mouse button to draw a contour by tracing the epicardium or
endocardium.

NOTE: Applying an RV contour to an LV contour may automatically flip the LV image to adjust Reference Points.
Ensure the anatomy matches the Reference Point before continuing.
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Figure 4-22: Clicking on the RV button after completing the LV mesh will enable RV contouring

4.2.3.1 4-CHAMBER RV MESH
Beginning at the valve plane, trace the epicardial contour by left-clicking periodically along the epicardium.

Change ©5%
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oo E oesw,ms

Figure 4-23: Beginning RV contour on 4Ch image
To finalize the first contour, double-click the last point once the apex of the RV has been reached. The contour will
automatically attach itself to the existing LV mesh.
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Figure 4-24: Completion of the epicardial RV contour

After completing the epicardial contour, use the same method to define the endocardial contour.

1425, 2825 ms -32 1425, 282.5 ms -32%

C0—; 06, 00— 00,

Figure 4-25: Completion of the 4Ch RV contour

NOTE: You can also click and hold down the left-mouse button to draw a contour by tracing the epicardium or
endocardium.
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4.2.3.2 3-CHAMBER RV MESH
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Figure 4-26: 3Ch view with RV button selected

Beginning at either the base of the RV or the top of the Basal Anteroseptal region of the LV, trace the epicardial
contour by left-clicking periodically around the epicardium.

2/25. 3565 ms . 32%
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Figure 4-27: Beginning the epicardial RV contour at the mid anterior region

After reaching the mid-anterior region of the heart where the LV and RV re-connect, double-click to complete the
contour.
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Figure 4-28: Completion of the epicardial RV contour

After tracing the epicardium, repeat the same process for the endocardial contour.

co0—] 00, 00— 00,

Figure 4-29: Endocardial contour drawn for 3Ch RV

After completing the RV contour, verify the analysis results are being displayed correctly in the Measurements
field of the Report.

4.2.4 END DIASTOLIC MESH AND TRADITIONAL MEASURES

In addition to calculating peak systolic strain, MyoStrain calculates traditional measures such as LVEF. These
measurements are calculated based on the Long Axis images and should be performed for each Long Axis view in
the study. Make sure the Ejection Fraction button in the Analysis Menu is checked before continuing.

User’s Manual LBL-1041EU_EN Rev F for v6.1 Page 71



A Strain measurements are not evaluated on Diastolic meshes.

To calculate traditional measures, first visually identify the frame best representing End-Diastole. This can be done
using the Slice Navigator, your mouse’s scroll wheel, or the CINE viewing buttons at the bottom of the Analysis
Window.

25/25, 946 ms -32%

oo s goe%éms

Figure 4-30: End-Diastolic meshed and viewed in the Slice Navigator

NOTE: The End-Diastolic timeframe is usually either the first or last image of a series. It is important to verify the
timeframe used is the closest to End-Diastole

After choosing the End-Diastolic timeframe, using the same mesh application methods used in section 4.2.1, apply
both an endocardial and epicardial contour to this image. MyoStrain also calculates RV Traditional measurements
if those contours are applied to the dataset.

2%
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Figure 4-31: End-Diastolic timeframe meshed with checklist showing completion of ES/ED Contours
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User’s Manual LBL-1041EU_EN Rev F for v6.1 Page 72



NOTE: RV Traditional Measurements are only available if Semi Auto Contouring is enabled

After both the systolic and diastolic frames have been meshed, their locations will be marked in the Slice Navigator
(Diastole in green, Systole in orange) and their measurements will be shown in the Measures section.

NOTE: Traditional measurements will only be pulled from the timeframes marked in the Slice Navigator. Use the
Set as ES and Set as ED buttons to re-identify these timeframes if a new time is used in the future.
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5. STRAIN EXAM REPORTING

Refer to this chapter of the MyoStrain User’s Manual to understand the workflow of a MyoStrain Exam. This
chapter should be followed once a patient is ready to be scanned.

5.1 MYOSTRAIN® TEST PROCEDURE

The MyoStrain Test procedure is a simple, fast, and non-invasive process. SENC- formatted Images acquired from
the scanner can be imported into the application through either the MyoWorklist or from the workstation if the
SENC formatted images are available locally. The below sequence of events is typical for a Strain exam:

Send SENC-Formatted images to the MyoStrain workstation.

Launch MyoStrain and import images from the previous step to be quantified and visually enhanced.
Review and update patient information, then view images in Analysis Window

Select a view from the Image List, then identify the best representative image for that view.

Quantify slice by applying a mesh or approving/modifying a mesh generated from Semi Auto contouring.

Repeat steps 4-5 for each slice over six total views (Basal, Mid, Apical, 3CH, 4CH, 2CH).

N o v r w N

Finalize report and export results.

5.2 IMPORTING SENC IMAGES

Upon launching MyoStrain from the desktop shortcut, the software will display a splash screen labeled “Select
Your Exam”. From this page, click the File menu and select either New Exam from Worklist, or New Exam from
Folder. If MyoStrain is configured to receive images directly from the MRI scanner or PACS, use the Worklist
option. Please refer to Chapter 10 for more detailed information about the MyoWorklist and how to launch a
dataset for analysis.
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Figure 5-1: Use the top shortcut if available, MyoWorklist is available inside MyoStrain

NOTE: The Worklist can be accessed directly from the Desktop or Start Menu through the MyoWorklist application.

If the analysis workstation is not networked or is unable to receive images from PACS, SENC formatted images can
be imported from a flash drive or from the local hard drive. Selecting File > New Exam from Folder will display a
Browse For Folder dialog box. Select a folder which contains a single SENC study (MyoStrain will automatically
identify if the dataset is a Strain or Stress analysis), then click OK.
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Figure 5-2: Exam Selection Screen

5.3 CONVERTING SENC IMAGES INTO MYOSTRAIN IMAGES

After selecting a dataset from either the Worklist or from a folder, MyoStrain will begin converting the SENC
formatted images into MyoStrain images. MyoStrain images refers to the colorized strain information displayed on
the image. Opening these images creates the .myo exam file (which contains the mesh information used to
identify the LV and RV) and will consume an exam credit and cannot be reversed.
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Figure 5-3: MyoStrain in Strain mode receiving images for processing in Semi Auto Contouring

During the import process, MyoStrain will also attempt to quantify the images by automatically applying
recommended meshes to each slice if the Semi Auto Contouring feature is enabled. Please refer to Chapter 9 for
more information regarding Semi Auto Contouring.

5.4 PATIENT DATA, IMAGE REVIEW, AND SELECTION

Once all images have been loaded into the MyoStrain software, confirm the correct patient’s information is
displayed in the upper-right corner of the Analysis tab. Review each MyoStrain image to ensure good image
quality is present, as well as to review the overall function of the LV/RV. If for some reason the image quality is
poor or there was an issue during acquisition, it is recommended to use a different slice if available. It may prove
beneficial to hide images so that they are not reviewed again.

If the image quality is good and strain data is clearly visible, proceed to quantify all six slices. Please refer to
chapter 4 for detailed instructions on image quantification.

5.4.1 SELECTING ONE VIEW BETWEEN MULTIPLE SLICES

If there are multiple slices available for one view, only one can be used for reporting purposes.

Figure 5-4 shows an off-plane slice on the top, and an on-plane slice on the bottom. Using the relative planes
when each slice is selected is helpful to identify where they are relative to other views to select the best one to
quantify.
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Figure 5-4: Top 4CH view shows poor planning based on the relative planes. Bottom 4CH is recommended since the relative
planes pass through the blood pool.

5.5 IMAGE QUANTIFICATION

Once the best view has been selected, review the video prior to analysis. Refer to chapter 4 for methods on
manually quantifying the mesh, and refer to chapter 9 if using Semi Auto Contouring as a primary mesh application
method. Once the mesh has been applied, accepted, and reviewed; proceed to the next view.

5.5.1 SIGNAL VS NOISE IN IMAGE ANALYSIS

In some situations, applying a mesh to a slice will not result in all segments being displayed in the Report Section.
If the mesh encounters a region where more than 50% the strain data is determined to be noise, the
Measurements section will display that region as “NA”. “NA” regions are displayed with black hatchmarks,
distinguishing them from unanalyzed slices, which are shown in grey. Both unanalyzed segments, along with
“noisy” segments, do not provide strain data towards the MyoHealth® score (for LV segments) or to global strain
measurements.
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Figure 5-5: Basal Slice analyzed showing the RV Anterior as “NA”

5.5.2 HIDING IMAGES

If multiple slices of the same view have been acquired, it may prove useful to move some slices out of the way to
ensure they are not included in the analysis. Right-clicking any image in the Image List will bring up a context
menu; selecting Hide will grey out the slice and move it to the far-right side of the image list. It can be unhidden
by right-clicking the greyed-out slice and selecting Unhide.

NOTE: Any slices which are not marked as hidden will be used to provide supplemental data to generate the 3D
Model.
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Figure 5-6: Hiding and Unhiding an image in the Image List

5.6 REPORTING AND EXPORTING DATA

After quantifying all six views of the current patient exam, it is recommended to save the quantified exam data
before proceeding to the MyoStrain Review tab to review the Polar Plots / 3D Model, or before exporting the
Strain Report and exam data to PACS or to the workstation directly. The Export to PACS button and Report to PDF
buttons in the lower-right corner of the Analysis tab will export the analysis to PACS (using default settings) or
export a local copy of the PDF report for printing or reporting purposes.

To save the exam, select Save from the File menu.

Motes

Conclusions and findings regarding the analysis should be
put here, this lex‘t] will be included in the Repaort.

Export to PACS| |Report To PDF

Figure 5-7: Export to PACS and Report to PDF buttons seen in the Analysis tab below the Notes and Patient Information sections

NOTE: The Export to PACS button will be disabled (grey) if a PACS connection has not been setup.

Please refer to chapter 7 for more information on the Report Viewer and exporting data from the MyoStrain
application.
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6. STRESS EXAM REPORTING

This chapter introduces the MyoStrain Stress Test post-processing analysis. Refer to this chapter of the MyoStrain
User’s Manual to understand the workflow of a MyoStrain Stress Exam. This chapter should be followed after a
Stress scan has been performed and images sent to the workstation.

6.1 MYOSTRESS TEST PROCEDURE

The MyoStress test is a simple and fast cardiac stress test which can be administered in a very short span of time.
SENC- formatted Images acquired from the scanner can be imported into the application through either the
MyoWorklist or from the workstation if the SENC formatted images are available locally. The below sequence of
events is typical for a Stress exam:

Send SENC-formatted images to the MyoStrain workstation.

Launch MyoStrain and import images from the previous step to be quantified and visually enhanced.
Review and update patient information, then view rest phase images in Analysis Window

Select representative slice from Image List for one view in the rest phase.

Quantify the current slice

Repeat steps 4-5 for each available view in the rest phase.

Advance to next stress phase, then repeat steps 4-6.

© N ok~ w NoR

After all stress phases have been completed, finalize the report and export the results.

6.2 IMPORTING STRESS SENC IMAGES

Upon launching MyoStrain from the desktop shortcut, the software will display a splash screen labeled “Select
Your Exam”. From this page, click the File menu and select either New Exam from Worklist, or New Exam from
Folder. If MyoStrain is configured to receive images directly from the MRI scanner or PACS, use the Worklist
option. Please refer to Chapter 10 for more detailed information about the MyoWorklist and how to launch a
dataset for analysis.
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Figure 6-1: Use the top shortcut if available, MyoWorklist is available inside MyoStrain

NOTE: The Worklist can be accessed directly from the Desktop or Start Menu through the MyoWorklist application.

If the analysis workstation is not networked or is unable to receive images from PACS, SENC formatted images can
be imported from a flash drive or from the local hard drive. Selecting File > New Exam from Folder will display a
Browse For Folder dialog box. Select a folder which contains a single SENC study (MyoStrain will automatically
identify if the dataset is a Strain or Stress analysis), then click OK.
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6.3 CONVERTING SENC IMAGES INTO MYOSTRAIN IMAGES

After selecting a dataset from either the Worklist or from a folder, MyoStrain will begin converting the SENC
formatted images into MyoStrain images. MyoStrain images refer to the colorized strain information displayed on
the image. Opening these images will create the .myo exam file which include the saved mesh information used to
identify the LV and RV. This action will consume an exam credit and cannot be reversed. MyoStrain will display
the Rest phase images on the left-hand side, and the Stress phase images will display on the right-hand side.
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During the import process, MyoStrain will also attempt to quantify the images by automatically applying
recommended meshes to each slice if the Semi Auto Contouring feature is enabled. Please refer to Chapter 9 for
more information regarding Semi Auto Contouring.

NOTE: MyoStrain will perform Semi Auto Contouring for each stress phase of the imported dataset. When the
Rest phase of images has been contoured, review can begin while MyoStrain processes the stress stages.

6.4 PATIENT DATA, IMAGE REVIEW AND SELECTION

Once all images have been loaded into the MyoStrain software, confirm the correct patient’s information is
displayed in the upper-right corner of the Analysis tab. Review each MyoStrain image to ensure good image
quality is present, as well as to review the overall function of the LV/RV. If for some reason the image quality is
poor or there was an issue during acquisition, it is recommended to use a different slice if available. It may prove
beneficial to hide images so that they are not reviewed again.

If the image quality is good and strain data is clearly visible, proceed to quantify all six slices. Please refer to
chapter 4 for detailed instructions on image quantification.

&‘ Traditional measurements are only calculated on the Rest phase.

6.4.1 SELECTING ONE VIEW BETWEEN MULTIPLE SLICES
If there are multiple slices available for one view in a single stress stage, only one can be used for reporting
purposes.

Figure 6-4 shows an off-plane slice on the top, and an on-plane slice on the bottom. Using the relative planes when
each slice is selected is helpful to identify where they are relative to other views to select the best one to quantify.
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Figure 6-4: Top 4CH view shows poor planning based on the relative planes. Bottom 4CH is recommended since the relative
planes pass through the blood pool.

6.5 IMAGE QUANTIFICATION

Once the best view has been selected, review the video prior to analysis. Refer to chapter 4 for methods on
manually quantifying the mesh, and refer to chapter 9 if using Semi Auto Contouring as a primary mesh application
method. Once the mesh has been applied, accepted, and reviewed; proceed to the next view.

6.5.1 SIGNAL VS NOISE IN IMAGE ANALYSIS

In some situations, applying a mesh to a slice will not result in all segments being displayed in the Report Section.
If the mesh encounters a region where more than 50% the strain data is determined to be noise, the
Measurements section will display that region as “NA”. “NA” regions are displayed with black hatchmarks,
distinguishing them from unanalyzed slices, which are shown in grey. Both unanalyzed segments, along with
“noisy” segments, do not provide strain data towards the MyoHealth® score (for LV segments) or to global strain
measurements.

User’s Manual LBL-1041EU_EN Rev F for v6.1 Page 83



train Numbers

ES LV Mode

HR:B 64 M 64 A 64

Stress

HR:B 64 M 64 A 64

Change

10/22, 3735 ms

HR:BO, MO AC

Figure 6-5: Stress Basal Slice analyzed showing the RV Anterior as “NA”

6.5.2 HIDING IMAGES

If multiple slices of the same view have been acquired, it may prove useful to move some slices out of the way to
ensure they are not included in the analysis. Right-clicking any image in the Image List will bring up a context
menu; selecting Hide will grey out the slice and move it to the far-right side of the image list. It can be unhidden
by right-clicking the greyed-out slice and selecting Unhide.

NOTE: Any slices which are not marked as hidden will be used to provide supplemental data to generate the 3D
Model.
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Figure 6-6: Hiding and Unhiding an image in the Image List

6.6 IMAGE ANALYSIS (STRESS PHASES)

After the Rest phase images have been processed, the next stage of stress should be displayed and reviewed prior
to analysis. By default, the images seen on the right-hand side of the Analysis tab are the stress phase images.

Figure 6-7: Multiple Stress stages acquired

The drop-down menu on the right-hand side shows the number of different stress stages identified by MyoStrain.
Switching the Acquisition # changes the displayed slices in the Stress side. The drop-down menu on the left-hand
side labels the Stress agent. The earliest acquisition is defaulted as Acquisition 1 and is set as the Rest phase of

images. The last series of images acquired and associated with this dataset should be marked with the highest
Acquistion #.

NOTE: When switching between stress agents to display for analysis, make sure to use the Acquisition dropdown
on the right to change images, not the label.

T Please refer to your site’s stress test procedure for specific instructions regarding testing procedure
and stress agent usage.
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6.7 IMAGE PROCESSING (STRESS PHASES)

After displaying the next stage of images from a new stress phase, analysis of the Stress phase can begin. When
clicking on a view in the Stress phase, the corresponding Active Rest view will automatically display on the left-
hand side of the Analysis Window for comparison purposes.

| M m W R e Ea "iqlv,&‘ " |

1/18. 605 ms 32

o of

R 1++-sth s<ore ccnsios + TSR] Wyorieatth Score % [ ]
Figure 6-8: Analysis Windows showing both Rest and with 10 Mics Dobutamine

Both Analysis Windows have the same behavior as before, except that the window must be highlighted (or active)
before interacting with it. The Rest images will always be shown in the left-hand window to allow comparison to a
later stress phase in the right-hand window.

NOTE: Brightness/Contrast adjustments will only affect views contained in the highlighted image’s series.

6.7.1 REJECTION OF IMAGES

During image acquisition, there may be several stress stages which are incomplete, or are not necessary for this
analysis. If a series of images needs to be removed from the analysis, selecting Reject as the Stress Agent will
cause that stage of images to be deleted from the exam.
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Figure 6-9: Selecting this option will remove any images and meshes from this acquisition stage from the analysis

T Image rejection will irreversibly remove images from the current exam. Images will need to be
imported into a new exam if this occurs.

Warning

; lx Reject stage will delete this stage, Do you want to continue?

Yes Mo

Figure 6-10: Warning message shown when attempting to reject a stress stage

6.8 REPORTING AND EXPORTING DATA

After quantifying all six views of the Resting phase, and six views of the highest Stress phase of a patient scan, it is
recommended to save the quantified exam data before proceeding to the MyoHealth Review tab to review the
Polar Plots / 3D Model, or before exporting the Stress Report and exam data to PACS or to the workstation
directly. The Export to PACS button and Report to PDF buttons in the lower-right corner of the Analysis tab will
export the analysis to PACS (using default settings) or export a local copy of the PDF report for printing or reporting
purposes.

To save the exam, select Save from the File menu.
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MNotes

Conclusions and findings regarding the analysis should be
put here, this tex‘t] will be included in the Report.

Export to PACS| | Report To PDF

Figure 6-11: Export to PACS and Report to PDF buttons seen in the Analysis tab below the Notes and Patient Information
sections

NOTE: The Export to PACS button will be disabled (Figure 6-11) if a PACS connection has not been setup.

Please refer to chapter 7 for more information on the Report Viewer and exporting data from the MyoStrain
application.
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7

7. REPORT VIEWER AND DATA EXPORT

The Report Page automatically composes a report from the various sources of information that are obtained during
the analysis. This report can then be uploaded to PACS or exported as a PDF document to be later archived or
printed out for later use.

7.1 REPORT VIEWER OVERVIEW

During a Strain or Stress exam, the Report Tab will display the corresponding report measurements during the
exam. Additionally, the report can be viewed alongside the Analysis tab, and measurements will automatically
update as SENC image processing progresses. When images are imported into a new exam, MyoStrain will
automatically format the report to display either a MyoStrain or MyoStress report.

NOTE: Stress exams generate a resting Strain report in addition to the Stress report.
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Figure 7-1: Top of the MyoStrain Report tab after completing a SAC Strain exam.

In this section, the below MyoStress report tab image will be used to outline the different sections of the Report
tab, and any requirements needed to generate specific measurements.
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Figure 7-2: Top of the MyoStress report seen after completing a SAC analysis

7.2 REPORT TAB (A)

|.-'1'u.na|],r5i5| | MyoHealth® Review

Report ET |

Figure 7-3: MyoStrain Ul Menu buttons

The button to access the Report tab has two faces, the normal display option, or the Pop-out option. Clicking the
text (left-hand side) of the Report button changes the MyoStrain Ul to display the Report. The Pop-out icon (right-
hand side) will instead display the report in a separate window, which can then be docked to a secondary monitor
to view analysis results during the analysis itself.

NOTE: Certain measurements cannot be displayed (such as Timing Metrics) in the pop-out report. Calculations
that take a long amount of processing time can only be displayed in the Report tab itself.

7.3 STRESS MEASUREMENT COMPARISON (B)

This section displays all available Strain measurements gathered from the current Stress study using a standardized
AHA model (see section11.3). This comparison section is only displayed during a Stress analysis. Traditional
measurements and index values can be found above the AHA models in the Measurements section. Strain
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measurements, both circumferential and longitudinal, are also displayed with strain ranges shown. Information
regarding the calculation of index ranges and normal can be found in section 11.4
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Figure 7-4: Stress Measurements section (seen only in MyoStress exams)

1. Resting AHA Models — Shows the colorized strain measurements from the Rest stage of images.

2. Resting Vitals — Shows the LV MyoHealth and RV MyoHealth score for the Rest Stage.

3. Stress AHA Models — Shows the colorized strain measurements from the highest stage of stress
available in the analysis.

4. Stress Vitals- Shows the LV MyoHealth, RV MyoHealth, as well as the Stress Agent used for this stage.

5. Change AHA Models — Shows the change between the Resting and Stressed stages.

NOTE: The Stress Agent displayed is determined by the highest stage of stress agent applied. They are ordered as:
Rest, 10MICS, 20MICS, 30MICS, 40 MICS, Atropine, Mechanical, Adenosine, Regadenoson, Breathing, and Stress.

MyoStrain Stress tests will display both resting strain and the strain calculated at the highest level of stress. The
MyoStrain report will only display slices which are marked with a green dot in the Image List and only display
segments if they exceed the signal/noise threshold needed to accurately report strain measurements. Below the
Stress exclusive section are the global MyoStrain and traditional measurement calculations.

7.4 GLOBAL MYOSTRAIN AND TRADITIONAL MEASURES (C)

The measures provided in the Global Measurements section of the Report tab are calculated as follows:

¢ Global MyoStrain® Measurements:
o MyoStrain (GLS) LV — Average percentage of peak strain calculated from all Short-Axis LV slices.
o MyoStrain (GCS) LV — Average percentage of peak strain calculated from all Long-Axis LV slices.
o MyoStrain (GLS) RV — Average percentage of peak strain calculated from all Short-Axis RV views.
o MyoStrain (GCS) RV — Average percentage of peak strain calculated from all Long-Axis RV views.
e LV Dysfunctional Segments
o Number of LV Segments > -10% — This displays the total number of LV segments calculated by
MyoStrain to have above -10% strain.
o Number of LV Segments > -17% — This displays the total number of LV segments calculated by
MyoStrain to have above -17% strain.
o RV Dysfunctional Segments
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o Number of RV Segments > -10% - This displays the total number of RV segments calculated by
MyoStrain to have above -10% strain.

o Number of RV Segments > -17% - This displays the total number of RV segments calculated by
MyoStrain to have above -17% strain.

e LV MyoHealth® - Derived measurement showing percentage of LV segments below -17% strain compared
to the total number of LV segments analyzed. It can be expressed by the formula [(# of LV Segments <= -
17%) / (# of LV Segments Analyzed)] * 100

e RV MyoHealth® - Derived measurement showing percentage of RV segments below -17% strain
compared to the total number of RV segments analyzed. It can be expressed by the formula [(# of RV
Segments <= -17%) / (# of RV Segments Analyzed)] * 100

e Traditional Measurements

NOTE: Traditional Measurements are derived from the 3D model generated through Semi Auto Contouring

but will default to 2D meshes if a 3D model cannot be created. Indexed values require the patient’s height

and weight to be listed in the report to generate the BSA (Body Surface Area) using the Du Bois formula.

o LVEF — Percentage of blood emptied from the left ventricle during systole.
o LVED Volume - Volume (in mL) of blood measured in the LV at Diastole measured across all
Long-Axis images. Indexed LVED Volume is calculated by the formula ( LVED Volume / BSA ).
o LVES Volume - Volume (in mL) of blood measured in the LV at Systole measured across all Long-
Axis images. Indexed LVES Volume is calculated by the formula ( LVES Volume / BSA ).
o LV Stroke Volume — Difference of volume (in mL) between the LVED Volume and LVES Volume.
Indexed LV Stroke Volume is calculated by the formula (LVED Volume Index — LVES Volume
Index).
o RVEF* - Percentage of blood emptied from the right ventricle during systole.
o RVED Volume* - Volume (in mL) of blood measured in the RV at Diastole measured across all
Long-Axis images. Indexed RVED Volume is calculated by the formula (RVED Volume / BSA).
o  RVES Volume* - Volume (in mL) of blood measured in the RV at Systole measured across all
Long-Axis images. Indexed RVES Volume is calculated by the formula (RVES Volume / BSA).
o RV Stroke Volume* - Difference of volume (in mL) between the RVED Volume and RVES Volume.
Indexed RV Stroke Volume is calculated by the formula (RVED Volume Index — LVES Volume
Index).
NOTE: Indexed values require the patient’s height and weight to be listed in the report to generate the BSA
(Body Surface Area) using the Du Bois formula (.007184* [Height(cm)*0.725] * [Weight(kg)*0.425]).
e Timing Metrics
NOTE: Timing Metrics calculations are based on cellular LV measurements rather than regional ones. Each LV
region (such as SAX Basal Anterior) is comprised of 4 cells aside from Long Axis Apical Cap segments (which are
calculated as a single cell)
o  Synchronicity Index MyoHealth - Percentage of LV cells with a better regional synchronicity
index than 0.9.
o Standard Deviation of Time to Peak Strain — Measurement in milliseconds measuring the
standard deviation of time between segments reaching peak strain
o Radius of Curvature — Sharpness of the peak strain curve. Radius is normalized against strain
percentage and the R-R-interval in milliseconds, resulting in a unitless measurement.

NOTE: * in the above chart notes that Semi Auto Contouring must be enabled and a completed 3D model is
required to generate these measurements.

Any indexed measurements require the BSA (Body Surface Area) to be populated before any values are shown.
The BSA is a derived calculation which requires the patient’s Height and Weight to be populated. The indexed
measurements are generated using the following formula:
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7.5 REGIONAL MYOSTRAIN MEASUREMENTS
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Figure 7-5: Regional MyoStrain measures seen during a Stress exam
Below the Global Measurements section of the Report tab, the regional AHA models for both Longitudinal and
Circumferential MyoStrain measurements for both LV and RV at systole. MyoStress exams will display the Rest
phase images first, followed by the Stress phase, then the comparison between the two.

NOTE: LV MyoStrain measurements are pulled from the middle-third of each LV Mesh, where RV MyoStrain
measurements are calculated across the entire myocardium between epicardial and endocardial RV contours.

When reviewing the Report tab, some enhancements are made to the values displayed to make reading easier.
e  Strain/Stress values shown in BOLD are strain values between -10% and -17%
e  Strain/Stress values shown in red (Dark Mode yellow) are strain values above -10%
e Change measurements shown in red (Dark Mode yellow) denote a reduction in strain between Rest and

Stress.
e Change measurements shown in blue (Dark Mode ) denote an increase in strain between Rest and
Stress
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7.5.1 STRAIN LEGEND

MyoStrain uses a unique color gradient to identify different strain values.. The color legend below provides a
basic guide to the meaning of each color.

-

+5% 0% -5% -10% -15% -20% -25%
Figure 7-6: Color Legend for Strain

For more information regarding the Strain Legend, please refer to Section 12.2.

In the Change section of the MyoStrain Stress Report, a different color scale is used. This section displays the
percentage change between the Rest images and the most recent Stress acquisition.

I N
-10% 10%

Figure 7-7: Color Legend for Change

Areas which were identified as having marked improvement under stress are displayed in blue, where regions that
had reduced function are shown in red.

7.6 IMAGE, DATA AND REPORT EXPORT (D)
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Figure 7-8: Export Options
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At any point, data gathered from the exam can be exported for later use. Depending on the analysis workflow,
different actions will be required to satisfy reporting requirements and should be identified before continuing.
Clicking on the File>Export menu will display all available export options for the currently displayed dataset.

NOTE: Please contact your Myocardial Solutions Representative for more information regarding reporting
requirements.

e Export Anonymous — Exports an anonymized copy of all available measurements, reports, and images
from the current analysis.

e Export Data — Exports a .csv or .xml file containing all raw strain values from all stress levels recorded
during the exam. Please refer to section 7.6.3 for more details regarding saving this file.

e Export to DICOM — Creates a folder in a specified location and exports a local copy of the DICOM images
that would typically be sent to PACS.

e Export to PACS - Pushes a copy of the final report and the analyzed MyoStrain images (with meshes) to
the PACS server (if configured to do so). Details about what information is being uploaded to PACS can be
found in the File>Setup>DICOM Export Settings menu.

e  Report to PDF — Exports a .pdf file containing the Report. The Stress Report will also contain a copy of the
Strain report. Please refer to section 7.6.3 for more details regarding saving this file.

e Image — Exports screenshots of views available in MyoStrain. Accessible only in the Analysis and
MyoHealth Review tabs.

e Video - Exports videos of views available in MyoStrain. Accessible only in the Analysis and MyoHealth
Review tabs.

7.6.1 ANONYMOUS EXPORT

1.} Export Anonymous

Choose folder Ci\Users\Win10VM\Desktop
Falder name MyoSenc_4_Anonymous
Patient Name MyoSenc_4_Anonymous
Patient ID ID_4
[ Save l l Cancel

Figure 7-9: Export Anonymous dialog box

Export Anonymous is an additional export option available within MyoStrain. Clicking this button will bring up a
dialog box with a few options:
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A. Choose Folder - This field will display the file path where all exam data will be exported to. A folder will
be created in this directory and data copied into it. The ellipsis button will allow the user to identify a
new file path for export.

B. Folder Name - This text box contains the folder name which will be created in the Choose Folder path.
This field may not contain the following characters: (*.“/\1[:; | =,)

C. Patient Name - This will overwrite the name of the exported patient with the contents of this text box.

D. Patient ID — This will overwrite the Patient ID of the exported patient with the contents of this text box.

E. Save - This begins the export process.

F. Cancel - This cancels the export process.

7.6.2 EXPORT TO PACS

After pressing the Export to PACS button, the MyoStrain application will ask to confirm where to export the data
(Figure 7-10). After confirming the export location, MyoStrain will begin processing and sending images back to
PACS (Picture Archiving and Communications System) for storage purposes. A window will appear in the
background of the MyoStrain application called the “Dicomizer”.

. Select PACS >
Server AE Title Server Port Number Server IP
MSI_CQRP 107 192.168.150.221
SERVERAET_01 104 192.168.1.1

Upload ][ Cancel

Figure 7-10: Clicking the Export to PACS button will display a PACS selection screen

The Dicomizer will display the current progress of images currently being uploaded. The MyoStrain application and
the progress window must remain open while images are still being processed. Closing the application or the
Dicomizer window will cancel the upload.

smdnz [x]
Ferdng. n
I - e 7/28) Dane) x|

Figure 7-11: Progress window for background image archival
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7.6.3 EXPORT DATA, REPORT TO PDF, AND EXPORT TO DICOM (LOCAL EXPORT)

Clicking on either the Export Data, Report to PDF, or Export to DICOM options in the Export section of the File
menu will launch a dialog box (Figure 7-12, Figure 7-13, and Figure 7-14) asking where to save data. The Export
Data dialog box asks whether the data should be saved as a .csv or .xml document.

\ Export Data

Choose folder CAUsers\Win10WM\Desktop G
File name Philips_PT1 _MyaStress Data
®csv O XML Save | | Cancel |

Figure 7-12: Export Data Dialog Box

.4 Save Report
Choose folder CAUsers\Win10WM\Desktop E]
Filz name Philips_PT1 _MyaoStress Report
Save l [ Cancel l

Figure 7-13: Save Report Dialog Box

. Export to DICOM

Choose falder CHUsers\Win10VM\Desktop E]

Folder name Philips_PT1 _MyoStress DICOM |

e | [

Figure 7-14: Export to DICOM Dialog box

Using this window, navigate to the location designated by your organization to save this report with the Choose
Folder (ellipsis) button, then click Save. The user may provide a unique name to the report by changing the File
Name text. Export to DICOM will create a folder to store the images in and is labeled Folder Name accordingly.
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8. PREVIEW MODE (IMAGE PLANNING)

Preview Mode is an additional operation mode available within MyoStrain. It is only available when launching
either a Stress or Strain examination from the Worklist.

In the Worklist, next to the New Exam button, a Preview button is available. Clicking on this button will launch the
Preview window.
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Figure 8-1: Worklist running with several datasets ready for Preview or analysis

Before any actual analysis begins, it may be useful to use Preview mode. This allows MyoStrain to display images
without consuming any exam credits. This feature is useful for verifying that all the correct SENC images have
been sent and that they are of sufficient quality for analysis before using an exam credit.

(. Preview Philips_PT4_14

Anatomy MyoStrain

Figure 8-2: Preview with many slices available, 2CH view currently selected
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NOTE: Any images imported using Preview mode will not consume an exam credit. The images shown cannot be
guantified.

The Preview window displays 3 different views at the top of the screen of the SENC images pulled from the
scanner. Clicking on any of the views in the Image List at the bottom of the Preview window will display that slice
in the following 3 views:

e SENC - These are the unencoded SENC images pulled from the scanner. The images when played back
shift between the High-Tune and Low-Tune images unique to the SENC pulse sequence.

e Anatomy — These are the SENC images recombined without applying the Strain map.

e MyoStrain — These are the SENC images with the colorized strain maps applied (default view in
MyoStrain)

SA_BASAL Anatomy MyoStrain

Figure 8-3: Preview Window showing Stress SENC images from the scanner
Using either the mouse scroll wheel, the arrow keys on the keyboard, or the CINE playback buttons found at the
bottom of each of the Analysis Windows, play through each slice to ensure no artifacts or image abnormalities are

present. The Preview window will also display all stages of stress acquired as part of the analysis as well.

After reviewing the images, close the Preview window to return to the MyoWorklist.
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9. SEMI AUTOMATIC CONTOURING WORKFLOW

Semi Automatic Contouring is an optional feature which automates most of the analysis process. Using this mode
allows the software to automatically apply a mesh to the image being analyzed. This feature can either be enabled
or disabled by default. Any meshes applied using Semi Automatic Contouring must be reviewed for accuracy before
completion. Methodology for sending images to the workstation is identical with or without automatic contouring
active.

The Semi Automatic Contouring feature is available for use in both the Strain and Stress examination modes. The
ability to enable and disable this functionality is controlled by the Semi Auto Contouring button in the Settings
menu found under File>Setup>Application Settings>Analysis Settings in the title bar. This option will only take
effect if there are no images currently loaded into the software. Restarting the MyoStrain program or beginning a
new exam will enable Semi Automatic Contouring.

o Seri Auto Contouring i
» K pm
SRR Move Hidden Slices "
» foar Fzia
Thumitnall Slice Order @ saasa S Crer

e Cancel

e ——

| Aoty Sattrge |

Figure 9-1: Semi Auto Contouring button checked

When Semi Auto Contouring is enabled, MyoStrain will attempt to apply a mesh for all Long-Axis and Short-Axis
images near End-Systole upon image import. Additionally, if Traditional Measurement Calculations are enabled,
Semi Auto Contouring will also attempt to identify the End-Diastolic timeframe for Long-Axis images and apply a
mesh for that image as well. If MyoStrain is unable to confidently apply a contour to the image, either LV or RV,
that mesh will not be drawn. Additionally, MyoStrain will also generate a 3D model and a polar-plot model which
show global strain maps over time. These models are dependent on mesh and image quality and will reflect the
quality of information displayed.

NOTE: Displaying timing metrics as well as RV Traditional Measurements requires Semi Auto Contouring to be
enabled.
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Figure 9-2: MyoStrain in process of receiving and analyzing Stress images

Immediately upon opening SENC images from either the Worklist or from a folder, MyoStrain will begin analyzing
them with Semi Auto Contouring. As soon as an image has been processed/analyzed, its thumbnail will be
updated in the Image List with a mesh attached. The lower-left region of the application will display progress
messages when importing/analyzing images and will read Ready when the current series of images has been
processed. All meshes created by MyoStrain through the Semi Auto Contouring tool will display as orange by
default and will not display any strain information in the report until accepted or updated.
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Figure 9-3: All images imported and analyzed, no measurements displayed in Analysis tab
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NOTE: If multiple stress stages are included in the dataset, the Resting images will be processed first. These
images can be reviewed, modified, and accepted while the software is contouring other stress stages.

Stress image analysis follows the same process as a Strain exam, and the highest stress stage will be used as the
representative Stress series. It’s highly recommended to perform the following steps when analyzing a dataset
with Semi Auto Contouring:

1. Review all images shown in the Resting phase by playing through the video for each slice and view.
a. Label Unknown slices appropriately (this will cause SAC to contour the slice)
b. Re-label incorrectly labeled slices (this may cause SAC to re-contour the slice)
2. Going in order from Basal, Mid, Apical, 3CH, 4CH, 2CH:
a. Identify the representative slice if multiple slices are present. (Hide unused slices)
b. Identify the End-Systolic timeframe (use the Change ES button if the End-Systolic timeframe is
not contoured, but is available on the slice)
c. Correct the suggested contours (both LV and RV if available) or apply missing contours if they are
not available.
d. Identify the End-Diastolic timeframe (use the Change ED button if the End-Diastolic timeframe is
contoured but not on the appropriate timeframe) if quantifying a Long-Axis image.
e. Correct the suggested contours (Both LV and RV if available) or apply missing contours if they are
not available.
3. Repeat steps 1 and 2 for each Stress stage (Acquisition with highest stress agent is reported on)

9.1 IMAGE REVIEW AND IDENTIFICATION

After the software has imported images and performed the Semi Automatic Contouring, it is imperative to review
all images for completeness and for accuracy. Each thumbnail in the Image List will display a suggested mesh (if
available) along with the yellow dot indicating that the view must be reviewed first. MyoStrain will not display any
strain calculations for that view unless a mesh has been manually reviewed/accepted. As with any automation
tool, the analyst is ultimately responsible for the quality of the analysis delivered.
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Figure 9-4: Newly imported Stress dataset using Semi Auto Contouring feature
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In Figure 9-4, an imported dataset has been contoured using the Semi Auto Contouring feature. The Display
Header at the top of the active Analysis Window describes the steps necessary to complete the analysis. By

clicking on the Accept Mesh button found at the top of the Analysis Window, no changes to the mesh will be
made and its strain measurements will be displayed in the report (Figure 9-5).
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Figure 9-5: Accepted mesh with measurements shown in comparison region of Analysis tab

Semi Auto Contouring will not apply recommended meshes to slices which exhibit poor image quality or are
labeled as “Unknown”. Selecting the appropriate view from the View Selection dropdown menu will prompt the
application to attempt meshing that slice. Re-labeling an incorrectly identified view may also cause the Semi Auto

Contouring tool to attempt to reapply a contour to that slice.
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Figure 9-6: Identifying an Unknown view prompts SAC to analyze the slice.

9.1.1 REVIEWING AND UPDATING RECOMMENDATIONS

If multiple views are available, it's recommended to view each slice to review image quality and to verify that the
software’s recommendations are valid. A typical workflow would review each slice for planning first before making
modifications or accepting the representative slice for each view. The estimated strain for each slice is shown
when that slice is displayed in the Analysis Window.
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Figure 9-7 — Planing shown for an offplane slice (top) and recommended slice (bottom)

Additionally, any adjustments or modifications to the Semi Auto Contour will result in the mesh being accepted;
except for changing the timeframe. If a new timeframe is selected, and the current mesh has not been accepted,
MyoStrain will display the mesh generated by Semi Auto Contouring for that timeframe.
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Figure 9-8- Clicking on the Change ES button shows the SAC contour for that timeframe instead of copying the existing mesh
like it typically would.

Once accepted, the mesh will change to the default color schema and its measurements will be displayed in the
report. Repeat this process until each of the 6 views have an accepted mesh indicated by a green dot in its
thumbnail in the Image List.
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Figure 9-9: Corrections to an Auto Contour cause the mesh to become accepted and reported on

9.2 TRADITIONAL MEASUREMENTS WITH SEMI AUTO CONTOURING

In addition to identifying and contouring End-Systole, the Semi Auto Contour feature will also try to identify and
contour the End-Diastolic timeframe as well. Like the End-Systolic mesh, the End-Diastolic timeframe must also be
manually reviewed before its calculations will be included in the report. After accepting or modifying the End-
Systolic mesh, right-clicking in the Analysis Window and selecting Move to ED or clicking the ED label in the Slice
Navigator will display MyoStrain’s suggested End-Diastolic mesh.
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Figure 9-10: Navigating to the suggested End-Diastolic timeframe

NOTE: MyoStrain will display a warning if any Diastolic timeframes have not been accepted, except for stress
stages. Reviewing/modifying/accepting diastolic timeframes will improve 3D Model and Polar Plot views.
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Figure 9-11: Before and after modifying the recommended Diastolic timeframe

NOTE: MyoStrain will use the 3D model generated from Rest stage SAC images to approximate traditional
measurements when possible. The 2D meshes will be used if the 3D model cannot be generated.
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10. MYOCONFIGURATOR (WORKLIST AND LDAP)

This chapter provides a detailed writeup of the MyoConfigurator, a tool used to configure how data is managed in
MyoStrain. This includes the MyoWorklist, a separate service installed alongside MyoStrain. This MyoWorklist is
responsible for managing images being sent to the MyoStrain application, hosting .Myo exam files stored in PACS,
and how they are presented in the software for analysis. The MyoWorklist service serves multiple purposes: receive
new images, preview new images without using an exam credit, revisit previous exams, and launch MyoStrain to
analyze any dataset received on command. Encryption, access rights, and user history are also configured here.

10.1 MYOWORKLIST SETUP AND LAUNCH

o New Exam from Werldia O

Facent Name Pacent D  Accesmon Number Sreview New Exam Cpen Bam Delete
Phiips_ T3 Phiipe PT3 [}
Phips_PTd Prevew |Staet Open [x]
Pravps P12 T (oeven| | St B
Phipz_PT1 Prevew Start Open mﬁid
Locasen: CiMysStomn ) Pace: 171

Figure 10-1: MyoWorklist running with multiple datasets available

By default, the MyoWorklist service will automatically launch on Startup and will run in the background listening
for new datasets. The Worklist itself can be opened from the Desktop shortcut or directly through MyoStrain using
the File>New Exam from Worklist feature.

NOTE: The Desktop MyoWorklist feature is unavailable if using MyoStrain in the LDAP authentication mode.

To configure MyoStrain to be able to receive images and exams from a remote modality (PACS server or MRI
scanner):
Navigate to the directory where MyoStrain was installed, then run the “MyoConfigurator.exe”
application. The default installation directory is: “C:\Program Files (x86)\Myocardial
Solutions\MyoStrain Test\######\Release”, where ###### is the version of MyoStrain installed.
v | Refease - a x

[ [ o

- Thes PC Local Dk (€0 Brogram Fies (x86 Wvacardiel Soubans MyoStram Test 53 Release

& Quick sccess % Mol ondigurator

Figure 10-2: MyoConfigurator requires Administrative privileges to run

1. Click on the Configure PACS tab of the MyoConfigurator program.
a. If Encryption has not been enabled, a pop-up prompt will appear asking to configure this
feature. Accepting this prompt will continue to the next step. It is recommended to use the
Encryption tab before/after setup to backup a copy of this encryption key.
2. Fill out the 2 available fields in the Client section which identify this workstation to your PACS Server.
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Client AE Title — The name which the PACS or scanner identifies as a MyoStrain workstation.
Client Port Number — Port which MyoStrain will listen on to receive images.

Directory to Receive Images (uneditable) — Path on the computer where any images
received through the network are saved. Exam data will also be saved in this location as
well.

Save — Press this button to save the information added to this section. Green confirmation
text will appear upon a successful save.

Fill out the 3 available fields in the Server section which match a scanner or PACS pushing images to
the analysis software.

a.

Server AE Title — Application Entity title of the PACS or scanner pushing images to
MyoStrain.
Server Port Number — Port which MyoStrain will transmit information back to the server.
Address Type — PACS servers can be identified via either Hostname, or IP address

i. Server IP —IPV4 address of the PACS server or scanner sending images.

ii. Hostname — Human readable identifier for a PACS server on the network
Receive Only — This option sets MyoStrain to ONLY receive images from a server entity
without sending information back. Selecting this option will only require the server’s AE Title
to be entered to receive images.

(' MyoConfigurator *

General Settings | Configure PACS | Encryption | Audit

Client
Client AE Title MyoSENC
Client Port Number 56253

s
tn

Directory to Receive Images CAMy

S

Server

Server AE Title

Server Part Number

Address Type
Host name =
Recsive Only O Clear ]
DICOM server saved successfully. .
rver saved succe y T ]
Server AE Title Server Port Number Server IP
SERVER_AET ‘104 ‘1 92.168.1.1 ‘ =) ‘
SERVER_AE2 |10? |MSI PACS | =) |

Figure 10-3: Sample Configure PACS setup

NOTE: Images received through DICOM Connectivity will be handled the same as images added directly to the
default receiving directory.

4.

Pressing the Ping button will test the connection. A notification will appear showing if the test was
successful or not.
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5. Pressing the Add button will save the current server’s configuration. The server information will
appear in a list at the bottom. Pressing the red minus button next to a server will delete that
connection.

NOTE: MyoStrain requires a server’s IP address to transmit data through the network. MyoStrain will only respond
to servers listed in the MyoConfigurator.

10.2 MYOCONFIGURATOR - GENERAL SETTINGS

Worklist and language settings can also be changed in the MyoConfigurator tool. The Worklist settings are found

in the General

Settings tab of the MyoConfigurator tool.

o MyoConfigurator >

General Settings | Configure PACS | Encryption | LDAP | Audit

Choose Images Path C:\MyoStrain | ]

MyoContigurator

Ohoose Images Path CAMycSemn

Select Language Engish

Study Time lterval 5 seconds
Study Foider Nasne E—

GPU Opticn No inmtegrated GPU used

Enabile LODAP v

Figure 10-4: Worklist Settings window

e Choose Images Path — Clicking the ellipsis button will bring up a Browse for Folder dialog box. Selecting a
folder from this location will cause MyoStrain to store all images received from PACS in this folder.

e Select Language — Selecting a language from this dropdown menu will restart the application and change
the default language to the selected one.

O O 0O 0O 0O ©°

o
e  Study
e  Study

Dutch

English

French

German

Italian

Portuguese

Spanish
Time Interval — Amount of time MyoStrain will wait when receiving images before timing out.
Folder Name — Folders created by MyoStrain to store images received through the Worklist will be

created using the criteria listed in the dropdown menu.
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o Patient Name - (0010,0010)
o Patient ID (default)- (0010,0020)
o  Accession Number — (0008,0050)
GPU Option — Enables/Disables GPU hardware acceleration.

Enable LDAP — If checked, MyoStrain will require a connection to a server running Active Directory, and
will authenticate users to access MyoStrain. Only users configured in the LDAP tab will be able to access
MyoStrain. This option is only available to authorized users, and configuration authorization is available

through Myocardial Solutions support.

10.3 MYOCONFIGURATOR ENCRYPTION SETUP

MyoConfigusator X
Genersd Sattegs | Configure PACS | Encryption  LDAP | Auda
Would you like 10 auto-generate the encryption key?
® Yo auto-generate No, | wil enter it manually
Generate Koy
CAlUsers\ad Documents
Path for Backup e Backup
CAllzars\admin' Documents
Path for Restore CUseSacmmncumenty

Figure 10-5: Encryption Tab of MyoConfigurator

When configuring the PACS/Network settings, MyoStrain will require that an encryption key is generated before
the connection is completed. This key is used to encrypt all data stored in the MyoWorklist. By default, the
encryption key is automatically generated by MyoStrain and information needed to regenerate this key is recorded

during the installation and configuration process. Figure 10-5 shows the default behavior, and clicking the
Generate Key button will confirm the usage of the default encryption schema. This key is unique to each

computer.

If a unique key is requested, clicking on the No option will display an entry field where a user-authorized key can

be supplied.

(' MyoConfigurator

General Settings | Configure PACS | Encryption | LDAP | Audit

Would you like to auto-generate the encryption key?

Yes, auto—generate@: Nao, | will enter it manually

| 0123456729012345673901 23456'."89[]1|

[ Add Key

l

Path for Backup ChUsershadminiDocuments ki

Path for Restore CAlsers\admim\Documents | Restore

Figure 10-6: User-Provided encryption key entry point
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NOTE: In the event where a user-provided key is used for encryption purposes, Myocardial Solutions will be unable
to provide a method to decrypt data if the encryption key is lost. Myocardial Solutions can provide decryption
capabilities if the default key was used.

e Path for Backup — The ellipsis button will let the user select where the encryption key should be exported
to. Clicking the Backup button will export the encryption key to the specified destination.

e Path for Restore — The ellipsis button will let the user select a key file to import. Only keys exported using
the Backup feature above can be restored using this method.

10.4 LDAP SETUP

During setup, if the LDAP option was selected, the MyoConfigurator will display an LDAP configuration window.

_ LDAP Credentials %

Server [P

Server Port Number

Admin Username

Password

Lave

e Server IP —IP Address or Hostname of the LDAP server

e Server Port Number — LDAP server port. Typical defaults are 389 for LDAP, and 636 for LDAPS.
e  Admin Username — LDAP Administrator Username.

e  Password — LDAP Administrator password.

NOTE: MyoStrain will display a warning message if the LDAP connection is insecure.

The first user configured on this connection will be identified as the Administrator user. After the LDAP connection
has been established, the admin user that setup the connection must now authenticate into the MyoConfigurator.
After launching the MyoConfigurator, navigate to the LDAP tab to configure the LDAP groups and users for
authorized access into MyoStrain. The Inactivity Timeout sets the amount of time (in minutes) MyoStrain will
remain open if a logged-in user does not perform any actions.
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Name Type Action
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Figure 10-7: LDAP Configuration Tab

10.4.1 ADDING LDAP USERS TO ROLES

Within MyoStrain, there are 3 configurable roles for users to be assigned: Admin, Analyst, and Reviewer. Both
individual users as well as user groups defined on the LDAP server may be used. Clicking on the Add from LDAP
button will display a search box. From there, searching for a name will display User/Group matches found in the
LDAP server, and clicking on the + button in the Action column will add that User/Group to the list.

Admin  Analyst - Rewewer

Add from LDAP. |
o —— o Add Roles From Ldep o
Type Action

Uses " User\Group analyst Search

Type Action

User %

renGroupAraiynl Uset

Save

Figure 10-8: Adding users to the Analyst Group in MyoStrain using the Add from LDAP button

10.4.2 LDAP ROLES AND RESTRICTIONS

The 3 roles in MyoStrain are the Reviewer, Analyst, and Admin. The capabilities for each role are defined below.

e Reviewer — This user cannot consume exam credits. Reviewers are only able to open and modify
previously performed exams. The New Exam from Folder option in MyoStrain and the New Exam button
in the MyoWorklist are disabled.
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e Analyst — This user can perform all actions that a Reviewer role can perform. In addition, Analyst users
are also able to use exam credits to start New Exams.

e Admin —This user can perform all actions that an Analyst role can perform. In addition, Admin users are
also able to access the MyoConfigurator tool to make changes to the application.

10.5 AUDIT LOGS

To review previous analysis activity in MyoStrain, the Audit tab in the MyoConfigurator provides access to the
Audit Logs. Access and ability to export Audit logs are only available to Admin users.

L MyoCenfigurator X

General Settings | Configure PACS | Encryption | LDAP | Audit

Archive Directory k:\Users-.acml'-u_Dc:-cumen:s | l

Retention Time 6 years

Expart Retention Time 7 days

Start Date 8/20/2025

End Date | 872772025 | | Clear Dates ‘

| Save ‘
| Export Audits ‘

Figure 10-9: Audit Logs Configuration section of the MyoConfigurator

e Archive Directory — Location where the Audit Logs will be stored. Network addresses may also be
specified.

e Retention Time — Records older than the specified timeframe will be removed from the database.

o Export Retention Time — Reports generated from this tool will be available N days after export.

e  Start Date — Beginning date that the exported Audit Logs will cover.

e End Date - Ending date that the exported Audit Logs will cover.

Audit logs are exported in a .csv format in chronological order. Each entry is timestamped with the logged-in user
and the actions performed by that user. The actions recorded in the Audit Logs are as follows:

e  Successful/failed logins (LDAP only)

e  Opening/Creating new exams

e Exporting data/DICOM images

e Modifying an existing exam (the slices/stages modified from the original exam are recorded)
e Deleting a dataset from the MyoWorklist

e Adding Exam/Application licenses to MyoStrain

e Timeout due to inactivity
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A B C D E E G
1 |Timestamp UserName ActionType Description
2 8/20/2025 10:35 admin MyoSecurity Mew License added successfully
3 8/20/2025 11:24 administrator Login Successful login from MyoStrain
4 8/20/2025 11:25 administrator Start Start case:3 for patient Philips_PT4with Id
5 8/20/2025 11:30 administrator Export Reportto PDF  Export report to PDF from MyoStrain Exam
6 8/20/2025 11:30 administrator Close Exam Finished Closing Exam Philips_PT4_20201
7 8/20/2025 11:31:22 AM administrator Login Successful login from MyoConfigurator

Figure 10-10: Sample Audit Logs

10.6 MYOWORKLIST FEATURES

The MyoWorklist is managed through 2 services that are running at all times on the workstation,
MyoWorklistService and MyoCheckerService. When active, regardless of whether MyoStrain is open or closed, or
if a user is logged in or not, the MyoWorklist will run in the background and receive any datasets pushed to it for
analysis. If the MyoStrain application is closed when a dataset is launched from the worklist, the worklist will
automatically launch MyoStrain and load the corresponding dataset.

NOTE: Check the Import Status is set to Ready or Sent before sending data to MyoStrain before processing.

3
3

x B

PATEN (s, JOVZIEMTES: <o

Figure 10-11: MyoWorklist actively downloading datasets

Once a dataset is received by the program, it is added to the list with an Import Status of Ready. The images are
organized based on their DICOM information and displayed for easy access. Clicking on the title of any column in
the MyoWorklist will sort the available datasets by that criteria. Default DICOM tags (####,##Ht#) are provided for
each entry if applicable.

Patient Name — (0010,0010) - Name of the patient as listed in the DICOM header
Patient ID — (0010,0020) - The ID of the patient
Accession Number — (0008,0050) - A unique ID that is generated for a patient record
Scan Date — (0008,0020) - YYYY/MM/DD of acquisition of listed dataset
Received — YYYY/MM/DD of when this dataset was pushed to the workstation for analysis.
Import Status — Details what state the images are currently. Hovering over this status will display the
total number of slices and images available to the dataset.
1. Archived — This dataset has been analyzed in MyoStrain and has been sent to PACS for archival or
reporting purposes.
2. Sent—This dataset has been sent to MyoStrain for analysis. This typically means an exam file is
available and clicking on the Start button will consume an additional exam credit .

mmoon® P
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3. Incomplete — This dataset is missing slices or images which would typically be found in a
MyoStrain exam. This includes cases with two or more missing slices, or with slices with fewer
than 5 timeframes of information.

4. Downloading - This dataset is still being downloaded. Analysis cannot begin until all images have
been received.

5. Ready - All images in the dataset have been received and are ready for analysis. (Tooltip shown
in Figure 10-12).

Import Status Exam Type Preview
Du:rwr-ing Preview
Archived MyoStrain® | Preview]
|Preview]
MyoStrain ® | Preview]
Sent e Preview
Rest | ]
Basal (1): 19 Images
Mid (1): 19 Images
Apical (1): 19 Images
3CH (3): 57 Images
ACH (3): 57 Images
2CH (3): 57 Images

Figure 10-12: Import Status showing information about the study, tooltips showing slice data

G. Exam Type — Displays the type of exam that will launch when consuming an exam credit (MyoStrain or
MyoStress).

H. Preview — This launches the Preview window. More information about the Preview window can be found
in chapter 8.

I.  New Exam* - This field holds the Start button, which will launch these images in a new MyoStrain exam.
MyoStrain will launch if it is not open already. *(This will consume an exam credit).

J.  Open Exam- If a dataset sent to the workstation has already been analyzed with MyoStrain and the Exam
File was uploaded to PACS, MyoStrain can open that previously analyzed exam. Clicking this will open the
folder containing the SENC images and any exam files associated with it (Figure 10-13)

K. Delete — This button will remove the dataset assigned to it from the workstation. A warning message will

display if images being deleted do not show the Archived Import Status (Figure 10-14). Multiple datasets

can be deleted at once by holding down the Shift key to highlight multiple cases, then clicking the X

button.

File Path — This shows where on the hard disk the exam data is located.

M. Page Navigator — A maximum of 100 entries are displayed in the MyoWorklist at a time. More pages will
appear when an excess of 100 entries are available in the worklist for analysis.

—
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Figure 10-13: Opening a previously analyzed exam archived on PACS and sent for review

After launching the MyoStrain program using the MyoWorklist, additional exams can be launched from here, or
from the worklist found within MyoStrain itself.

Pavent ID

. S Tyoe Preview
‘LA'— m | Warring B Ctan® ||
0000 Thes acion will ramove the selected datssetis) and all maocuted data Strant® |Prevew Start
U= _PT3 ‘ B from the ﬁavd grive. This canndt De undone : jrv— Desvian) Start
Pisase make suse cxam data has boen backed-up or sent 1o PALS —1
Prilips P74 before deletion (Srreas® [Prevew Start
abeaefghiidmancpgretuvmy Do you wesh to conbnue? Gtran 2 v Chart

Page 1/

Figure 10-14: Warning message shown when attempting to delete images from the MyoWorklist

NOTE: MyoStrain will automatically determine if a Strain or Stress exam will be launched based on the images

received. If Stress images are included with the patient scan, a Stress exam credit will be consumed. Opening an
existing exam will not consume an exam credit.
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Figure 10-15: Multiple datasets can be selected at once by holding Shift or CTRL. Deleting one highlighted dataset will prompt
removal for all highlighted cases.

10.7 IN-PROGRAM MYOWORKLIST

When working within MyoStrain, the MyoWorklist can be accessed by clicking the New Exam from Worklist option
from the File menu (Figure 10-8).

(. MyoStrain ® Test[Exam_7]

File | View
Mew Exam Ctrl+N

| Mew Exam from Worklist
Mew Exam from Folder b

Cpen Analyzed Exam...
Open Recently Analyzed Exams 4
Open Anonymized Myo Exam

Figure 10-16: Open from Worklist option in the MyoStrain File menu

The New Exam from Worklist option will launch an in-application version of the MyoWorklist. From here, pressing
the Start button will close the currently open exam (if available) and launch the selected one.

Prrern Name P— Ascman Nurte ScnOate Aucewed repert Status  Exiom Type Prevven NewErsm  Open Exem Deiety
2000 un /7010 20257108 MpoSirns2 Freyen St i ]
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Figure 10-17: New Exam from Worklist dialog box as seen from MyoStrain

NOTE: MyoStrain will automatically determine if a Strain or Stress exam will be launched based on the images
received. If Stress images are included with the patient scan, a Stress exam credit will be consumed. Opening an
old exam will not consume an exam credit.
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11

11. MYOHEALTH® REVIEW TAB

This section reviews in detail the features and viewing capabilities of the MyoHealth ® Review tab. Information
regarding exporting the 3D Model, Polar Plots, and how to manipulate or view these new additions are provided
here as well.

The MyoHealth Review tab is opened by default whenever a previously analyzed dataset is opened in MyoStrain.
Navigation to other sections of the application such as the Report or the Analysis page can be accessed by the
buttons in the top middle portion of the application.

Warning: The 3D Model and the Polar Plots are provided for reference. The models are an
approximation based on image quality and results gathered from Semi Auto Contouring. Regional
strain calculations and measurements can be found in the Report.

11.1 COMMON FEATURES AND REQUIREMENTS

Some features of the MyoHealth Review tab are dependent on certain analysis requirements to be met before
they can be utilized. The majority of viewing capabilities are enabled when Semi Auto Contouring is able to
successfully contour a dataset with high confidence.

NOTE: When applying the colorized strain information to the 3D Model and Polar Plots, some regions of the
myocardium may not have corresponding strain information to display. In those cases, the strain is shown grey.

11.1.1 3D MODEL

The 3D Model is generated from the meshes applied to the dataset. There are two 3D models created for each
stage of stress images analyzed, one depicting Longitudinal Strain, the other Circumferential Strain. If the dataset
was analyzed without the use of Semi Auto Contouring, or if the 3D Model cannot be fully generated, it will only
display a rendering of the Systolic timeframe.

Figure 11-1: 3D Model generated using dataset contoured with Semi Auto Contouring
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The 3D model will only provide video playback if Semi Auto Contouring was enabled and could apply contours to
most of the slices available to it during the analysis. The 3D model will only provide an RV if the RV contour was
applied during the Analysis phase. Additionally, if the Trigger Time DICOM tag (0018,1060) is unavailable, the
playback time will default to a 1 second interval.

The playback buttons in the 3D Model view function identically to the Analysis tab. In addition, there are
additional visualization features enabled on the 3D Model which are exclusive to this view.

NOTE: If the 3D model could not be generated, the thumbnail will be replaced with an ‘X’. The 3D model
thumbnail will display in grey, regardless of the strain calculated for the exam.

11.1.1.1 3D MODEL VISUALIZATION FEATURES

When the 3D model is displayed, by default the anterior wall of the myocardium is displayed in front, with the
Basal region near the top of the screen, and the apex at the bottom. The mesh can be freely rotated by holding
down the left-mouse button and moving the mouse cursor in the window.

Stress: Circumferential

376.23 ms

(> (D—Q— 0 @

Figure 11-2: Target icon will display when rotating the 3D Model

Additionally, holding down the CTRL button on your keyboard will change the Scroll Wheel’s behavior in the 3D
Model to allow zooming in and out of the image.

11.1.2 POLAR PLOTS MODEL

The Polar Plots model shows strain information calculated from meshes applied to the dataset. There are two
Polar Plots models created for each stage of stress images analyzed, one showing Longitudinal Strain, the other
Circumferential Strain. If the dataset was analyzed without the use of Semi Auto Contouring, the Polar Plots will
only display a rendering of the Systolic timeframe. The grey dotted line in the middle of the LV portion of the Polar
Plots represents the septal wall of the LV.
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Figure 11-3: Polar Plots generated from dataset using Semi Auto Contouring

Additionally, the Polar Plots will provide video playback only if Semi Auto Contouring was able to apply contours to
a majority of the SENC images provided during the analysis. This also holds true for RV contours as well. If the
Trigger Time DICOM tag (0018,1060) is unavailable to MyoStrain, the playback time will default to a 1 second
interval.

11.2 MYOHEALTH® REVIEW - STRAIN LAYOUT
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Figure 11-4: Default layout of the MyoHealth Review tab during a Strain exam.

A. Longitudinal Viewing Window — Displays the currently selected Short Axis image from the Image List

B. Circumferential Viewing Window — Displays the currently selected Long Axis image from the Image List.

C. Longitudinal Image List — Shows only the active Short Axis slices analyzed during the Analysis portion of
MyoStrain, including the Longitudinal 3D Model and Polar Plots.

D. Circumferential Image List — Shows only the active Long Axis slices analyzed during the Analysis portion of
MyoStrain, including the Circumferential 3d Model and Polar Plots.

E. Global Measurements — Shows the same global measurements available in the Report tab.
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F. Patient Information and Checklist- Shows the same information available in the Analysis tab.

When reviewing a Strain exam using the MyoHealth Review tab, Long Axis and Short Axis views can be shown
simultaneously. Longitudinal Strain based meshes will be shown in the top, where Circumferential Strain is shown
at the bottom. When multiple views are shown on opposing axes, both Relative Planes will be shown in the Image

lists.

Basal

Longitudinal

INF
HUSTAMTLAT

118 373.5 ms

S——

o@f

o

Circumferential

Figure 11-5: Relative planes showing orthogonal planes when viewing multiple slices simultaneously

NOTE: Thumbnails in the MyoHealth Review tab will display the peak strain values calculated from the mesh, not

the aggregate strain thumbnails seen in the Analysis tab.
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11.3 MYOHEALTH® REVIEW — STRESS LAYOUT
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Figure 11-6: Default layout of the MyoHealth Review tab during a Stress Exam
When reviewing a Stress exam in the MyoHealth Review tab, each view selected will display both Rest and Stress
images simultaneously. The 3D Model and Polar Plots views will show both the Longitudinal and Circumferential
images of the Rest and Stress series simultaneously when selected.

A. Rest Viewing Window — Displays the currently selected MyoStrain image’s Rest view from the Image List
(Polar Plots and 3D model will show the Longitudinal version here)

B. Rest Viewing Window (secondary) — Displays the corresponding Circumferential 3D Model or Polar Plot
model when that view is selected from the Image List.

C. Stress Viewing Window — Displays the currently selected MyoStrain image’s Stress view from the Image
List (Polar Plots and 3D Model will show the Longitudinal version here)

D. Stress Viewing Window (secondary) — Displays the corresponding Circumferential 3D Model or Polar Plot
model when that view is selected from the Image List

E. Image List — Shows the accepted MyoStrain slices analyzed during the Analysis portion of MyoStrain,

including the 3D Model and Polar Plots.

Switch Stage — Changes the thumbnails displayed in the Image List from Rest to Stress and vice versa.

Strain Regional Measurements — Shows the same measurements available in the Report tab. Hovering

the mouse cursor over a segment will display the strain value for that region in the AHA model.

H. Patient Information and Checklist- Shows the same information available in the Analysis tab.

am

NOTE: Thumbnails in the MyoHealth Review tab will display the peak strain values calculated from the mesh, not
the aggregate strain thumbnails seen in the Analysis tab.
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12. EXTERNAL REFERENCES AND RELEASE NOTES

This section outlines any references to outside materials not produced by Myocardial Solutions. These include
third-party software libraries and research references.

12.1 THIRD PARTY APPLICATIONS

MyoStrain makes use of multiple third-party libraries which assist with processing and displaying information.

absl-py - Python application build package

Accord — Used for exporting video.

AssimpNet - Memory management module

astor - Used for reading and writing ASTs (Abstract Syntax Trees).

cffi - Used to call C code from Python.

cryptography - Used for secure data storage or transmission.

DICOM# - Library for processing DICOM Formatted data

Eigen - Library for linear algebra, matrices, vectors and related maths.

EO.PDF - Processes and formats PDF documents

FO-DICOM - Library for processing DICOM images

gast - A generic AST to represent Python AST.

GLM - Library for linear algebra, matrices, vectors and related maths. For easy compatibility with OpenGL.
Gma.QrCodeNet.Encoding.dll - Generates QR codes available on MyoStrain reports
google-pasta - Library used to help with merging and refactoring of Python code.
grpcio - Supports gRPC, a high-performance, open-source universal RPC framework.
h5py - Allows for storing and manipulating data within the HDF5 format.

HelixToolkit. WPF.SharpDX - 3D model processing

IJG Library - Processes JPEG compressed DICOM data

importlib-metadata - Used for package management and accessing package metadata.
joblib - Used for parallel computing and caching.

Keras-Applications - Deep learning model library

Keras-Preprocessing - Utilities for image preprocessing.

LibJpeg.NET - Compresses JPEG data

Log4Net - Generates log files

Markdown - Text-to-HTML conversion tool.

MarkupSafe - Implements a XML/HTML markup safe string.

MediaToolkit - Video processing and exporting

Newtonsoft.json - Generates QR codes available on MyoStrain reports

Nlog — Library used to add logging to the 3D Model module

nlohmann_json - Library for loading and reading jsons

numpy - Package for scientific computing in Python, essential for handling arrays and matrices.
OpenCV - Library for linear algebra, matrices, vectors and related maths.
opencv-python - Open source computer vision library, used for image transformations, drawing contours
and other image processing tasks.
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e opt-einsum - Optimizes Einstein summation for multidimensional arrays.

e pandas - Data analysis and manipulation libary, useful for managing structured data.

e protobuf - Google's mechanism for serializing structured data, used for model saving and data exchange
in TensorFlow.

e pycparser - A C parser in Python, useful for interfacing with C code or libraries.

e python-dateutil - Provides extensions to the standard datetime module.

e  pytz - Brings the Olson tz database, allows for accurate timezone calculations.

e scikit-learn - Machine learning library for Python.

e scipy - Library used for scientific and technical computing.

e  SharpAVI - Library to export videos from MyoStrain

e SharpDX - DirectX processing for 3D Model

e  SharpZiplLib - Archive processing

e six - Helps with maintaining code that is compatible across Python versions.

e spdlog - Library for logging.

e stb_image - Library for loading images.

e tensorboard - A tool for providing visualization for machine learning workflow.

e tensorflow-directml - TensorFlow variant that uses DirectML for backend, enabling TensorFlow to run
DirectX 12 compatible GPUs.

e tensorflow-estimator - A high-level TensorFlow api that simplifies Machine Learning training and
predication.

e termcolor - Useful for making logs and console messages more readable.

e threadpoolctl - Manages thread pools for BLAS libraries, specific for controlling parallel computing.

e  TinyGLTF - Library for loading and saving 3D models using gITF.

e Topshelf - Service implementation

e typing_extensions - Enables the new type system on older Python versions.

e  Werkzeug - WSGI web application library.

e wrapt - A module for decorators and wrappers.

e zipp - Useful for handling package data and resources.

Additionally, MyoStrain includes the following applications as part of its installation:

e .NET Framework 4.8 (if not already available)

e  Visual C++ Redistributable Package 2019

Detailed information related to these libraries including version numbers are available upon request through
support@myocardialsolutions.com.

12.2 MYOSTRAIN STRAIN SCALE

MyoStrain utilizes mechanical strain, which can be defined as the deformation of a material when compared to a
baseline state. MyoStrain measures how much the heart contracts between its baseline state (at diastole) and
under strain (at systole), and this is typically a negative ratio under normal circumstances. Strain is a “unitless”
measurement as it is the ratio of two lengths, and it can be expressed as a fraction or a percentage value.

More information regarding the strain legend used in the MyoStrain program can be found from the following
papers:
e Neizel M, et al. “Strain-encoded MRI for evaluation of left ventricular function and transmurality in acute
myocardial infarction.” Circ Cardiovasc Imaging. 2009;2(2):116-122
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e Wong DT, et al. “Magnetic resonance-derived circumferential strain provides a superior and incremental
assessment of improvement in contractile function in patients early after ST-segment elevation
myocardial infarction.” European Radiology. 2014;24:1219-1228.

e Oyama-Manabe N, et al. “Identification and further differentiation of subendocardial and transmural
myocardial infarction by fast strain-encoded (SENC) magnetic resonance imaging at 3.0 Tesla” European
Radiology. 2011;21(11):2362-2368.

o Neizel M, et al. “Impact of Systolic and Diastolic Deformation Indexes Assessed by Strain-Encoded Imaging
to Predict Persistent Severe Myocardial Dysfunction in Patients After Acute Myocardial Infarction at
Follow-Up.” Journal of the American College of Cardiology. 2010;56:1056-1062.

e ChoiE-Y, et al. “Prognostic value of myocardial circumferential strain for incident heart failure and
cardiovascular events in asymptomatic individuals: the Multi-Ethnic Study of Atherosclerosis.” European
Heart Journal. 2013;34:2354-2361.

e Koos R, et al. “Layer-specific strain-encoded MRI for the evaluation of left ventricular function and infarct
transmurality in patients with chronic coronary artery disease.” Int J Cardiol. 2013;166:85-89.Korosoglou,
G et al. “Fast Strain-Encoded Cardiac Magnetic Resonance for Diagnostic Classification and Risk
Stratification of Heart Failure Patients” JACC Cardiovasc Imaging 2021 Jun;14(6):1177-1188. doi:
10.1016/j.jcmg.2020.10.024.

e Steen H, et al. Left and right ventricular strain using fast strain-encoded cardiac magnetic resonance for
the diagnostic classification of patients with c hronic nonischemic heart failure due to dilated or
hypertrophic cardiomyopathies and cardiac amyloidosis. JCMR. 2021;23:45. doi:10.1186/s12968-021-
00711-w.

e Korosoglou, G., et al . Systematic review and meta-analysis for the value of cardiac magnetic resonance
strain to predict cardiac outcomes. Sci Rep 14, 1094 (2024). https://doi.org/10.1038/s41598-023-50835-5

e Korosoglou, G et al. 2019 Strain-encoded magnetic re sonance: a method for the assessment of
myocardial deformation ESC Heart Fail. 2019 Aug; 6(4): 584—602.doi: 10.1002/ehf2.12442

e PezelT, et al. Regional strain score as prognostic marker of cardiovascular events from the multi-ethnic
study of atherosclerosis (MESA). Front Cardiovasc. Med. 2022;9:870942

e Steen H, et al. Multi-parametric non-contrast cardiac magnetic resonance for the differentiation between
cardiac amyloidosis and hypertrophic cardiomyopathy. Clinical Research in Cardiology. 2023.
doi:10.1007/s00392-023-02348-4.

12.3 AHA MODEL

The AHA Models used in MyoStrain are derived from the following publication:

M. Cerqueira et al., “Standardize Myocardial Segmentation and Nomenclature for Tomographic Imaging of the
Heart,” Circulation, 2002;105:539-542

12.4 NORMAL RANGES OF MYOSTRAIN MEASUREMENTS

The output of the SENC images post-processing is a report that shows various measurements. One set of
measurements is the traditional global measurements (ejection fraction and chamber volumes). These
measurements are presented with the normal ranges published by Zhan et al [1]. The other set is the strain
measurements (circumferential and longitudinal) presented with the normal ranges of strains as published by
Neizel et al [2].

The LOA and accuracy of Strain calculations were based on tests using a mechanical phantom with known actual
strain values. Phantom analysis demonstrated that MyoStrain has the acceptable LOA of (-5%,+5% (absolute)).
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Traditional Global measurements (LVEF and indexed LVEDV, LVESV, and LVSV):

[1] Y. Zhan et al., "Derivation of consolidated normal reference values for right and left ventricular quantification
by cardiac magnetic resonance using a novel meta-analytic approach," Journal of Cardiovascular Magnetic
Resonance, vol. 18, no. 1, p. 075, 2016/01/27 2016.

Strain (circumferential and longitudinal):
[2] M Neizel et al. “Strain-encoded MRI for evaluation of left ventricular function and transmurality in acute
myocardial infarction.” Circ Cardiovasc Imaging. 2009;2(2):116-122.

12.5 ACCURACY OF MYOSTRAIN 2D MEASUREMENTS

The accuracy of MyoStrain measurements will be determined by the LOA with measurement from CMR
measurements. LOA is the difference (disagreement between the measurements of the two devices) range within
which fall 95% of all the measurements from the two devices. The LOA depends on many factors, including images
quality and inter-operator and inter-observer variabilities. Based on the Bland-Altman analysis of previously
published LOAs of traditional measurements from different imaging modalities versus cardiac MRI (Wood PW et al,
2014 & Crean AM et al, 2011), we use the following bounds for the 95% LOA between MyoStrain and CMR data
from the Prefect study.

e LVEF: (-20%,+20%)

e LVEDV: (-45mL,+45mL)
e LVESV: (-25mL,+25mL)
e LVSV: (-40mL, +40mL)

Based on a sample size N=175 analyzed exams, MyoStrain demonstrated the following acceptable LOA:
e LVEF: (-14%,+16%)
e LVEDV:(-32mL,+36mL)
e LVESV: (-22mL,+19mL)
e  LVSV: (-30mL,+35mL)

The Bland-Altman Graphs of these calculations can be seen below:
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12.6 ACCURACY OF 3D MYOSTRAIN GLOBAL MEASUREMENTS

The accuracy of Myo3D measurements will be determined by the Limit of Agreement (LOA) with measurement
from CMR measurements. LOA is the difference (disagreement between the measurements of the two devices)
range within which fall 95% of all the measurements from the two devices. LOA depends on many factors,
including images quality and inter-operator and inter-observer variabilities. Based on the Bland-Altman analysis of
previously published LOA of traditional measurements using different imaging modalities versus cardiac MRI
(Wood PW et al, 2014 & Crean AM et al, 2011), we use the following bounds for the 95% LOA between Myo3D and
CMR data from the Prefect study.

e LVEF: (-20%,+20%)

e LVEDV: (-45mL,+45mL)

e LVESV: (-25mL,+25mL)

e  LVSV: (-40mL,+40mL)

e RV EF: (-20%,+20%)

e RVEDV: (-100mL,+100mL)
e  RVESV: (-50mL,+50mL)

Based on a sample size N=175 analyzed exams, MyoStrain demonstrated the following acceptable LOA:

e LVEF:(-11%,+13%)

e LVEDV:(-26mL,+19mL)
e LVESV:(-21mL,+15mL)
e LVSV:(-24mL,+29mL)
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RVEF: (-6%,+16%)
RVEDV: (-34mL,+37mL)
RVESV: (-26mL,+14mL)

The Bland-Altman Graphs of these calculations can be seen below:
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12.7 TIMING METRICS

e Toro-Salazar O, et al. Identification of subclinical myocardial dysfunction by fastSENC cardiac magnetic
resonance imaging in cardio-oncology patients. SCMR.2023 January 26;1349140.

e Dodeja A, et al. Novel tem poral strain parameters to assess dyssynchrony using fSENC in congenital heart
disease. SCMR. 2023 January 27;1348910

12.8 RELEASE NOTES

e  When configuring LDAP, MyoStrain will not alert the user if an insecure connection is being used if the
Administrator’s username is preceded by the domain (DOMAIN/USERNAME).

e The MyoConfigurator will crash if a blank value is entered as the support code when configuring the LDAP
connection.

e When upgrading from MyoStrain 6.0 and 6.0.1, Traditional Measurement calculations and Semi-Auto
Contouring will be enabled by default.

e When reviewing a Strain exam in the MyoHealth Review tab, using the Reset Window Layout feature will
not reset the Notes section of the GUI.

e The MyoConfigurator will allow a server to be configured with a null hostname; this is not recommended.

12.9 LICENSING AND TROUBLESHOOTING

In some rare circumstances, the MyoStrain application license can fail. These licensing errors can occur if the
MyoStrain workstation is modified, the system clock is manually updated, or if MyoStrain is left running while
performing operating system maintenance/updates. In cases where the application license is compromised, an
error code will display and MyoStrain will not launch. Please contact your Myocardial Solutions representative (or
contact support@myocardialsolutions.com), and provide them with a copy of the error code received.
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Some common error codes can be found below. If your error code is not listed, please contact Myocardial
Solutions for more information.

MYO_0010 The CPU does not match the CPU noted during installation.
MYO_0021 The Application License has expired.

MYO_0049 Inconsistency between recorded/current hardware identifiers.
MYO_0089 Exam License has been activated in MyoStrain already.
MYO_0106 Inconsistency between recorded/current registry identifiers.
MYO_0140 Mismatch between internal exam license counts.
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13

13. GLOSSARY

This chapter lists the various terms used in this User Manual along with their meaning.

AHA Model
The standardized 17 segment heart representation set by the American Heart Association

Anonymous
Without identification. Without any additional external information. The identity of the person cannot be
established.

CINE
Movie-like MR imaging. In CINE, MR imaging data is acquired using cardiac gating to form a "movie" sequence of a
structure moving in synchrony with the heart.

EF
Ejection Fraction

Endocardium
The innermost layer of tissue that lines the chambers of the heart.

Epicardium
The outer layer of heart tissue.

Exam
A specific type of imaging for specific information. For example, MR tagged images acquired under stress.

fSENC
Another name for the SENC Pulse Sequence. fSENC is a single-heartbeat SENC acquisition.

GUI
Graphical User Interface

Lv
Left Ventricle

LVEDV
Left Ventricular End Diastolic Volume

LVESV
Left Ventricular End Systolic Volume

LVSv
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Left Ventricular Stroke Volume

MR
Magnetic Resonance - is primarily a medical imaging technique most commonly used in radiology to visualize the
internal structure and function of the body.

Myocardium
The muscular tissue of the heart. This is typically referring to the middle layer of the heart wall.

RV
Right Ventricle

Series
Collection of MR images acquired in a single MR scan.

SENC
Strain Encoding

Strain

Deformation of a material when compared to a baseline state. MyoStrain measures how much the heart contracts
between its baseline state (at diastole) and under strain (at systole), and this is typically a negative ratio under
normal circumstances. Strain is a “unitless” measurement as it is the ratio of two lengths, and it can be expressed
as a fraction or a percentage values. Geometrical measure of deformation representing the relative displacement
between particles in a material body.

Stress
Measure of how the myocardium responds to exertion.

Study
A collection of series scanned in the same session for a subject.
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14. INDEX

AE Title, 2.4
Analysis Window, 3.2,3.2.2

Brightness, 3.2.2

CINE, 3.2.3,4.1,4.2

Contour, Long-Axis 4.2, 4.2.2
Contour, Short-axis 4.1, 4.1.3
Contrast, Adjustment 3.2.2
CSV, Export 7.5

DICOM 2.4
Export 5.5, 6.6, 7.5
Heart Rate 3.2, 3.2.1,7.3

Image List 3.2.2,3.3,5.4.1,6.3.1
Import 2.3, 2.3.1, 2.3.2

Language, Change 10.4

Legend, Strain 3.2.4,7.3.1

License, Activate 2.2

License, Exams Remaining 3.5, 3.5.1

Mesh, Adjustment 4.1, 4.1.3,4.2,4.2.2
Mesh, Application 4.1, 4.2

MICS 3.2.1, 6.4

Myo Exam File (DICOM) 3.6
MyoHealth® 7.3.1

PDF, Export 1.3,7.5,7.5.3

Port 2.4

Preview 3.4.1, 3.5.1,

Reject 5.4.1, 6.3.1

Report, 3.4,3.4.1,7.1,7.5
Report, Conclusion, 3.4, 7.4
Report, Export, 7.5.2, 7.5.3
Report, Measures, 3.4, 7.3
Report, Notes, 3.4, 7.4
Report, Patient, 3.4, 7.2
RV, Contour, 4.1.4,4.2.3
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Strain, 2.6, 3.2.4,5,7.3.1
Strain, Reproducibility 1.5
Stress 2.6, 6, 7.3.1

Timeframe, 3.2, 4
Undo, 3.2.2,4.1.3,4.2.2

View Details, 3.2.1, 3.2.2
View Dropdown, 3.2.1, 4.1, 4.2

Worklist, Disable, 10.2
Worklist, Enable, 10.3
Worklist, Import, 10.1
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